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1 Overview

The Relativity Desktop Client (RDC) provides the functionality for importing document load, image, and production
files, as well as for exporting production sets, saved searches, and folders. You can also use this utility to import and
export object data.

1.1 RDC menu bar

The RDC menu bar appears above the workspace folder structure. It includes the following menu options:
File:

¢ Open - switches between different workspaces.

e Exit - closes the RDC.

e Refresh - updates the folder browser.

Tools - Import:

e Image File - imports images from a page-level load file.

* Document Load File - imports native files, document metadata, and extracted text from a document-level load
file.

e Production Load File - imports productions from a page-level load file.

Tools - Export:
¢ Production Set - exports production sets.
e Saved Search - exports from saved searches.
o Folder - exports from a specific folders.
e Folder and Subfolders - exports from a specific folder and its subfolders.
Options:
o Settings - changes the default value for Force Folder Preview and enter a WebService URL.

e Check Connectivity - assists with troubleshooting network and system configuration errors that occurred while
importing and exporting.

Help:

e About - displays the version of the RDC.

* Help - opens the Relativity Desktop Client documentation in your internet browser.

1.2 Workspace folder options

The RDC provides right-click options on folders, which you can use to build the workspace folder structure, or to
import and/or export directly to and from a folder.
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Help

Mew Folder...

Import r
Export 3

When you right-click on a workspace or folder, the following menu options display:

* New Folder - create subfolders. In the Add New Folder pop-up, enter a folder name, and then click OK. The
maximum length for the folder name is 255 characters. Since the folder name is a system field, once you create
it, you can't edit it. The new folder is added to the workspace through the RDC.

e Import - import an image file, document load file, or production file into a specific folder. Highlight the folder,
point to Import, and select a file type. If you have metadata, natives and images to load, run the load file import
first, then the image file import. See Importing through the RDC.

» Export - export a specific folder, or a folder and its subfolders.

Relativity Deskiop Clier

Help

New Folder...

Import 3

-

Folder...
Folder And Subfolders...

Export

1.3 Starting the RDC
To open the RDC:

1. Double-click on the shortcut installed on your desktop. The Settings dialog box appears when you open the
application for first time.

=

" Relativity Desktop Client | Settings =B )
—anrce Folder Presiew Default |

|Enabled -l

| webService URL |

Ihttps:a’a’relativit}l.kcura. com/relativitywebap]

| k. I Cancel
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2. Select or enter settings for the following options:

e Force Folder Preview Default - options to enable or disable this feature. When enabled, the RDC
checks the first 1000 records of the load file after you click Import. It then displays the number of folders
soon to be created. You can use this information to ensure that the load process is behaving as expec-
ted. If a large number of folders are listed, you can stop the load file, and verify that the Folder Info field
is set correctly. By default, this feature is Enabled.

e WebService URL - enter the URL provided by your system admin. This URL is used to establish a con-
nection between the RDC and your server. If the URL path is entered incorrectly, you are unable to con-

nect the RDC to your database.

The WebService URL has the format http or https://<MyServiceName>/RelativityWebAPI/. When you
display a Relativity page, you see the web service name listed in the address bar on the browser. For
example, if the address bar displayed https://smith.com/Relativity, then your web service URL would be
https://smith.com/ RelativityWebAPI/. In addition, you can confirm this URL with your system admin.

3. Click OK. These settings are stored in your machine registry and they are retained when you upgrade the RDC.

1.4 Logging on to the RDC

Tolog in to the RDC, enter your Username and click Continue. Then, enter your Password and click Login.

These are the same credentials you use to log in to Relativity. If the server certificate is untrusted, you can allow using
untrusted certificate or close the RDC. Additionally, if you have difficulty displaying the login dialog, verify that
Relativity is a trusted site in your browser.

Note: Users log in to the Relativity Desktop Client (RDC) with the same provider method as they have with
Relativity. The RDC supports most Relativity authentication providers, such as password, Integrated
Authentication, and OpenlD Connect, by displaying the Relativity login page within the RDC as a dialog window.
The only provider that does not work with the RDC is SAML because the Relativity’s |dP-initiated SAML does not
display the Relativity login page directly.

| Relativity Login — O X | Relativity Login — O 4

Username Password

[ismith@example.com IITIE TR Y )

T

After you log in, the RDC displays a list of workspaces where you have access rights. Use the filter bar to narrow the
list.
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Note: By default, Relativity uses a wildcard to filter workspaces in the RDC. For example, enter ELA to find
workspaces named ELAN and Relativity.

Highlight your workspace and click OK to open it in the RDC. The folder structure of your workspace displays. A new
workspace contains only a root folder, while an existing workspace may contain subfolders that you can display by
clicking the plus sign.

I 1

@ Relativity Desktop Client El

File  Tools  Options Help

Drocument _:J

!Wnrkspace Loaded - File Transfer Mode: DirE| -

Note: In Relativity Desktop Client, Document is selected by default as the type of object for data import or export.
You can also select other object types, including Relativity Dynamic Objects.

1.5 RDC OAuth2 client

The RDC uses the OAuth 2.0 authorization framework for verifying your login credentials. The OAuth 2 client offers
increased security, because it uses an access token that is valid for only three days. After the token expires, you must
log in to the RDC again. Any jobs currently in progress fail when the token expires.

On your SQL server, you can extend the token lifetime by editing the [AccessTokenLifetimelnMinutes] field in the
[EDDS].[eddsdbo].[OAuth2Client] view.

For general information about using OAuth2 in Relativity, see OAuth2 clients in the Relativity Admin guide.

1.6 RDC transfer modes

RDC supports the following data transfer modes:

» Direct- uses the file share client. Direct mode provides the fastest transfer speed. Note the following details:

e Direct mode uses the windows Active Directory account and has direct access to write to the file repos-
itory or the BCPPath. This bypasses the need to go through the web server in order to ingest the data,
saving a significant amount of time.

e There are two direct modes to be aware of:
e Direct Mode for native files - requires read/write access on the workspace file repository (so that
native/image import/export is direct to the share).

» Direct Mode for file metadata - requires Read/Write access on the BCPPath for metadata. Docu-
ment metadata passes through the BCPPath, not native files.

e Web - uses the HTTP client. Because of the limitations of the HTTP protocol and varying network bandwidth, it
is the slowest. Note the following details:

¢ When you don't have read/write permissions to the BCPPath, Relativity must authenticate via the web
server.
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* When you don't have read/write permissions to the workspace file repository, Relativity must authen-
ticate via the web server.

¢ When loading through web mode, you can see a drastic performance reduction compared direct mode.
Web mode is the slowest method of all, it does, however, work without direct access to the BCPPath.

When you select a Relativity workspace, the RDC queries the workspace and performs tests to determine the optimal
transfer mode. You can see the details of the tests under Options > Check Connectivity:

[ Relativity Desktop Client | Connectivity Tests — O *

The workspace information was retrieved. ~

Preparing to test Aspera connectivity.
Testing Aspera upload.

Aspera upload successful.

Testing Aspera download.

Aspera download successful.
Testing Aspera ports.

Aspera connection test is successful.

Preparing to test Direct connectivity.
Testing Direct upload.

Checking default repository access: W \FileShare‘files*
Created temporary directory in the repositony: YW\ “FileShare files"Connection Test_a73205%-31f6-dafc-57e543c218847ec ™,
Created temparary file in the repositany: W\ “File Sharefiles\Connection Test_a732b39b-316-4afc-97e53c 21884 Vec P impSE4B tmp

Direct upload successful.

Testing Direct download.

Downloaded file from the repository.

Deleted temporary directory in the repository: %\ WFileShare'files\Connection Test_a732h%5%b-3116-dafc-57e b 3021884 Ve
Direct download successful.

Direct connection test iz successful.

Preparing to test Web connectivity.

Testing Web upload.

Web upload successful.

Testing Web download.

Web download successful.

Retrieving default repository drive information:

Success - report follows:
Drive Mame: “\File Share*files".
Free Space: 481,853.805 MB
Used Space: 541,602.199 MB
Total Space: 1,023,456.004 MB
WFree: 47.08 %
%lsed: 52.92 %

Web connection test is successful.

The RDC then automatically selects the optimal available mode for the transfer job.

Note: You can select more than one mode for the transfer job based on your configuration. The fastest mode will be
displayed first.
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(% Relativity Desktop Client — O et
File  Tools  Options Help

Workspace Loaded - File Transfer Mode: Aspera

Note: The mode initially selected based on the tests for the workspace may not be used in the actual transfer, for
example due to a connection problem. If a problem occurs, RDC falls back to a different mode or displays an error.

The transfer mode also displays on the RDC progress window.

L Relat|V|ty Desktop Client Guide 9



(8 Import Load File Progress ... — O et

83
End upload T3962a1b-8393-45%-37h1-51cbb183520e’ file. (778ms] [line 83]

25 of 686 processed

Summary I Ermors I Progress I Wamings I Report I

Start Time: 2:53:08 PM
Duration: 00:00:14

Time Left to Completiom: 00:01:40

Total Becords: €2¢

Total Processed: 28

Total Processed w/Warnings: 0
Total Processed w/Errors: 0

Lverage file transfer rate: 777.20 EB/sec
Current bkatch size: 1,000

File Transfer Mode: Aspera,Metadata: Pending

You can also force the RDC to use a specific mode.

1.6.0.1 Transfer Mode Statuses
The following statuses may display during the transfer:

e Pending - displays when transfer mode is not yet determined.

» Disabled - displays when File Repository Preference is set to not copy files.

1.6.1 Direct mode

Direct mode provides faster performance, but it requires a connection to the network hosting the data, as well as
specific Windows group permissions. Direct mode has direct access to write to the file repository, which bypasses the
need to go through the web server in order to ingest the data, saving a significant amount of time.

1.6.1.1 Setup
The following conditions must be met in order to load data using direct mode:

e The Active Directory account running the load must have direct access to the Relativity File Repository and
BCPPath folder.

e The loaded data must be located on the Relativity system network/domain.

e The computer running the Relativity Desktop Client must be located on the Relativity system network/domain.

@RelatIVIty Desktop Client Guide 10



e The group of users responsible for uploading documents through the Win Relativity component (Relativity
Upload Users) must have Full Control in the Document Repository Share. This allows members of this group to
import and export in Direct mode. Non-members can only import and export in Web mode. the Pre-installation
guide.
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2 Using the RDC installer

To use the Relativity Desktop Client (RDC), you must download a copy of the RDC installer and then install it.

Note: To ensure a safe and stable product experience, effective with the Server 2024 release, we only support the
version of RDC that was shipped with the current release as well as one release back. For example, Server 2024
RDC will work with both Server 2023 and Server 2024 but not with any releases prior to Server 2023.

2.1 Software requirements

The RDC installer checks for the software prerequisites. If you're missing any of the prerequisites, your computer must
have Internet access, so the RDC installer can fetch the required software. If your computer doesn't have Internet
access, the RDC installer can't fetch the required software, so the installation fails.

Note: You do not need Internet access to install the RDC if your computer has all the prerequisites.

The RDC requires the following software:

¢ Microsoft .NET 4.6.2 or above

» Redistributables listed in the following table:

Operating System | VC++2010 (x86) | VC++2010 (x64) | VC++2017 (x86) | VC++2017 (x64)

32-bit v v
64-bit v v v v

Note: If you need to perform an offline installation, you must manually install the software required for the RDC
listed in this section.

2.2 Downloading the RDC installer
To use RDC, you must first download a single executable file that runs on both 32-bit and 64-bit operating systems.

To download the RDC installer file:

1. Open your workspace in Relativity.

2. Selectthe Workspace Admin tab.
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3. Click Workspace Details to display the Relativity Utilities Console.

e Lo Lo L

Other

Record History

Workspace Information

Resource Information

Detault File Repository:
Data Grid File Repository:

Default Cache Location:

: Data Testing

- RelativityOne Client
- RelativityOne Matter
: Active

: RelativityOne Pool

Whles\TO10WFilesh

Default Cache
Location

Created: Wendt, Eric - 121272018
3:30:52 PM GMT

S@L Full Text Language:
Client Number:
Matter Number:
Production Restrictions:

Workspace Admin Group:

Database Location: clus01412810W01.5gl-

English
1

Billing

—

y001.r1 keura. comctus01412810W01

Enable Data Grid: Yes

Download Handler URL: Relativity Distributed

Last Modified: Service Account, Relativity -

121272018 3:31:20 PM GMT

RELATIVITY UTILITIES
System Settings

Manage Workspace Permissions
Manage System Keyboard Shortculs

View Another Users Personal ltems

Relativity Downloads
Viewar Installation Kit

Relativity Deskiop Client

4. Click Relativity Desktop Client under the Relativity Downloads selection. Relativity downloads the Relativ-
ity.Desktop.Client.Setup.exe.

5. Complete the steps for installing the RDC. See Installing the RDC for more information.

2.3 Installing the RDC

After downloading the installer file, you can proceed with installing it.

Toinstall the RDC:

1. Complete the steps to download the Relativity.Desktop.Client.Setup.exe in Downloading the RDC installer.

2. Double-click on Relativity.Desktop.Client.Setup.exe to launch the installer.

fHRelativity

Desktop Client Guide

13




3. If you want to specify an installation location, complete these steps:
a. Click Options.

Relativity Desktop Client Setup — x

Relativity Desktop Client

Publisher: Relativity ODALLC

Setup Options

Install location:
| Browse

OK Cancel

b. Click Browse to select a directory where you want the RDC installed. The default installation directories

include:
32-bit—C:\Program Files (x86)\kCura Corporation\Relativity Desktop Client

64-bit—C:\Program Files\kCura Corporation\Relativity Desktop Client
c. Click OK.

The RDC installer checks for the software prerequisites. If you're missing any of the prerequisites, your
computer must have Internet access, so the RDC installer can fetch the required software. If your computer
doesn't have Internet access, the RDC installer can't fetch the required software, so the installation fails.

Note: You don't need Internet access to install the RDC if your computer has all the prerequisites.

4. Click Install on the RDC setup wizard to start the installation.

5. Click Close when the installation has completed.

Note: The executable for the RDC has been renamed to Relativity.Desktop.Client.exe. If you use an
antivirus scan in your environment, you may want to update your settings to accommodate the renamed RDC

executable.

Your desktop now displays a shortcut icon for the RDC, which you can click to launch it.

EH

Relativity
esktop
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2.4 Installing the RDC in quiet mode

You can use quiet mode to run unattended RDC installations through the command line. Open a command prompt
and enter the following:

Relativity.Desktop.Client.exe /g /log InstalllLog.txt /INSTALLFOLDER "<RDC Install-
ation Directory>"

This command takes the following parameters.

Parameter Description
/INSTALLFOLDER | Specifies a custom installation path. This parameter is optional.
/log Used to create a log file. Specify a file name and path for the log file. This parameter is

optional.

Iq

Runs the installation in quiet mode.

2.5 Repairing or removing RDC installation

You can also run the installer to repair, or remove an existing installation of the RDC. Run the installer on a machine
where the application is installed. Select one of the following options:

» Repair—attempts to fix errors in the most recent installation.

¢ Uninstall—removes the RDC from your machine.

HRelativity
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3 Importing through the RDC

You can import document load files, as well as image and production files, through the Relativity Desktop Client
(RDC). You need to install the RDC on your computer before you can perform an import.

Note: You must be logged in to a Relativity environment in order to successfully import files.

You may also use the Windows Command Line to import documents into Relativity. With the Windows Command Line
you can automate document importing along with other parts of your processing and integration process. See the
Command Line Import guide.

3.1 Importing RDC Permissions

The following permissions are required to use the importing feature in Relativity Desktop Client:

Object Security Tab Visibility Admin Operations
e Document: View, e Documents o Allow Import
Add, Edit

Note: Changing root folder permissions during import is not a supported workflow.

3.2 Importing multiple load files simultaneously

You can safely import multiple load files into the same workspace simultaneously. For best results, use multiple
machines and one active instance of the RDC per machine.

Note: We recommend limiting this to four concurrent imports at a time into one workspace.

3.3 Handling errors

Relativity skips any records with errors that it encounters during the load process. It warns you about any errors that
were encountered after all the correct records have loaded.

B X

Errors have ocorred. Export error files?

oK Cancel

When you click OK in the error warning box, Relativity creates a new document-level load file with only the erroneous
records. This file lists all the errors that occurred during the load process. You are prompted to save these records to
prevent any loss of data. Choose a path to save your error file and click OK.
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After you have saved your error file, you can make any necessary corrections to those records, and then perform an
Append Load. A record of these errors is also available in the Errors tab, referencing the workspace name and
Artifact ID.

3.4 Saving import settings

You can save the settings used to import a load file. This option is helpful if you frequently work with your own internal
processing tools or with the same processing vendor. To save your import settings, point to the File menu, and then
click Save Import Settings. Choose a location for the document load file (.kwe).

Note: .kwe stands for kCura Win Edds.

The settings for the selected destination path and for copying files to a repository aren't saved in the .kwe file.

When you have an identically formatted load file, you can use your saved .kwe. In the RDC, open the .kwe file, and
select the file being loaded.

You can also update the path in the .kwe file. The following illustration displays the text of a .kwe file. The fourth line
contains an absolute path to the document-level load file to be loaded. Update this section to point to your new load
file. After you have updated your .kwe file, select File and Load Import Settings. Test for any errors, and then load
the file.

sampleowe | - x
tSOAP-ENV :Envelope xmlns: xsi="http: - wew_ v3. m#Eﬂﬂl/xH'I.Scheu-mstanr-'

<SOAP-ENV : Body>
tal LoadFile id=" =

- pf t . com clr ns.
<FilePath id="ref-¥:C: \U==rs‘-Dan‘-D== tup\Tl:stDuta daL(Fnll:Fathl* H

tFirstLinsContainsHeseds = e
¢1IoadHativeFiles>talzec ToadNat iveFiles>

tExtractFul ITextFromfativeFile:falssd ExtractFul lTextFronfativeFs le:
(ExtractMDSHashFromHativeFilerfalse< ExtractHDSHashFromNativeFile:
‘FecordDaliniteyr>20< FecordDelini tex >

(Cuocteleliniter>254< Tuotelelimiter:
tHevlineDalimiter: 174 HevlinaDaliniter:
{MultiRecordDelimiter»59<-HultiRecordDeliniter

tOvervriteDestinat ionrHonec Overvritebestination:

(Fimldiap href="Ffref=4°-3

HativaFilaPathColunn %=1 niall=s"1"3 -

el b AT b S B el 21 S L £ ek

Jf nr - I.

3.4.1 Saving a field map

You can save the field mapping used to import a load file. The field map is exported as a CSV file that saves the
mapping of the Relativity fields to those in the dat file being imported. You can save or view your field map from the
Field Map tab or from the File menu in the Import Document Load File window. To save your field map:
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1. From the Import Document Load File window, click View/Save Field Map. The Selected Field Map window

opens.

2. Click Export to CSV.

Destination Field | Source File Column

Cortral Mumber [Identifier] | Cortral Mumber (2)
Conversation Conversation (5)
Custodian - Single Choice | Custodian (7)

Date Created Date Created (2)

Date Last Modffiad Date Last Modified (3)
Date Received Date Received (10)
Date Sent Date Sert (11)
Document Extension Document Edension (12)
Email BCC Email BCC (13)

Note: When importing a CSV file with currencies, the formatted column must be Number.

3.5 Viewing audit information for an import

After you import your file, the RDC records and audits this instance in the History tab. Click Import to display the
settings used for the import. To view the transfer rate of the load file, add the Execution Time field to the view, if

necessary.

3.6 Load file specifications

Using load files, Relativity can load the following types of files. The sections below detail the load file requirements for

the respective file types.

» Metadata, extracted text, and native files
e Image and extracted text files

¢ Processed data

3.6.1 Supported file types

Relativity accepts only the following load file types:

o .dat
° .CSV

o ixt

L Relat|V|ty Desktop Client Guide
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3.6.2 Metadata, extracted text, and native files

Relativity uses a flat, document-level load file to load metadata, document level extracted text, and natives files. Each
line should represent one document.

3.6.2.1 Encoding

The Relativity Desktop Client (RDC) attempts to determine the encoding of a file, by default, when a load file is first
selected. To do this, the RDC checks the byte order mark at the beginning of the file. If there is no byte order mark, it
cannot determine the encoding type. The types of byte order marks include:

e Unicode (UTF16)
e Big-Endian Unicode
 UTF8

Everything else is considered undetectable by the RDC and uses the default encoding chosen for the load file or
stand-alone extracted text file.

A variety of load file encoding options are supported, including:

e Western European (Windows)

e Unicode

e Unicode (Big-Endian)

e Unicode (UTF-7)

e Unicode (UTF-8)

e Other options, based on your SQL sever
3.6.2.2 Header row
Relativity doesn't require load file header rows. However, they are strongly recommended to ensure accuracy.
The field names in your header don't need to match the field names in your workspace.

3.6.2.3 Fields

Relativity doesn't require any specific load file field order. You can create any number of workspace fields to store
metadata or coding. During the load process, you can match your load file fields to the fields in your workspace.

The identifier field is required for each load.
When loading new records, this is your workspace identifier.

When performing an overlay, you can use the workspace identifier or select another field as the identifier. This is
useful when overlaying production data. For example, you could use the Bates number field rather than the document
identifier in the workspace.

All fields except Identifier are optional; however, you may find some of the following system fields beneficial.

1. Identifier—the unique identifier of the record

2. Group Ildentifier—the identifier of a document’s family group
e The group identifier repeats for all records in the group.

e Usually, this is the document identifier of the group’s parent document. For example:

 [f an email with the document identifier of AS00001 has several attachments, the email and its
attachments have a group identifier of AS00001.
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« If a group identifier for a record is not set, the document identifier populates the group identifier field in the
case. This effectively creates a “group” of one document.

3. MD5 Hash—the duplicate hash value of the record
* You can enter any type of hash value (and rename the field in your case).

» If documents share the same hash value, Relativity identifies the documents as a duplicate group.

e Ifahash field for a record is not set, the document identifier populates the hash field in the case. This
effectively creates a “group” of one document.

4. Extracted Text—The text of the document. Either the OCR or Full Text.
» The extracted text appears in the viewer and is added to search indexes. This field can contain either:
e The actual OCR or Full Text

e The path to a document level text file containing the OCR or Full Text. The path to a document
level text file containing the OCR or Full Text. Both relative and absolute paths are supported (use
Windows-style formatting containing backslashes "\").

5. Native File Path—the path to any native files you'd like to load.
e Bothrelative and absolute paths are supported.

6. Folder Info—Dbuilds the folder browser structure for the documents.
¢ This field is backslash “\” delimited.

 If not set, the documents load to the root of the case.
e Each entry between backslashes is a folder in the Relativity folder browser.

* Each backslash indicates a new subfolder in the browser.

Note: For example, if the load file contained the following entry in the folder info field: “Slinger,
Ryan\Email\deleted_items”
Relativity would build the following folder structure:

E]|_| Singer, Ryan
: E|| ~| Email
. L[5 deleted_items

Each document with the above entry would be stored in the “deleted_items” folder.

7. Relativity Native Time Zone Offset—Relativity’s native viewer technology displays all email header dates
and times in GMT. This numeric field offsets how email header dates and times appear in the viewer.

 If the value in this field is blank, or 0, for a document, then the email header date and time appears in
GMT.

e You can enter a whole number in this field — positive or negative — to offset the time from GMT to the local
time zone of the document.

e For example, if the document was collected from US CDT time, enter “-5” in the field, because the
CDT offset from GMT is -5.

e This ONLY applies when viewing email header dates and times in the Relativity Native File Viewer. Your
metadata fields display as imported.

3.6.2.4 Accepted date formats

Relativity accepts date and time as one field. For example, Date Sent and Time Sent should be one field. If date sent
and time sent ship separately, you must create a new field for time. You can format date fields to accept the date
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without the time, but not the time without the date. Dates can't have a zero value. Format dates in a standard date
format such as “6/30/2017 1:23 PM” or “6/30/2017 13:23".

Note: When you import data using a load file with a date format that differs from the format used on your local
machine, Relativity follows the locale setting of your local machine to determine how it interprets what is in the load

file.

The table below lists the date formats recognized by the Relativity Desktop Client and the Import API. It contains both
valid and invalid date formats:

T lesd Bl | Definition
Type
12/31/9999 12/31/9999
0:00
Monday January 4 | 1/4/2018
2018 0:00
05/28/2016 7:11 AM | 05/28/2016
7:11 AM
5.08:40 PM 6/30/2019 The current date will be entered if the date is missing. For this example,
17:08 assume the import was done on 6/30/2019.
17:08:33 6/30/2019 The current date will be entered if the date is missing. For this example,
17:08 assume the import was done on 6/30/2019.
17:08 6/30/2019 The current date will be entered if the date is missing. For this example,
17:08 assume the import was done on 6/30/2019.
5:08 PM 6/30/2019 The current date will be entered if the date is missing. For this example,
17:08 assume the import was done on 6/30/2019.
14-Apr 4/14/2019 The current year will be entered if the year is missing.
0:00
9-Apr 4/9/2019 The current year will be entered if the year is missing.
0:00
14-Mar 3/14/2019 The current year will be entered if the year is missing.
0:00
1-Mar 3/1/2019 The current year will be entered if the year is missing.
0:00
22-Feb 2/22/2019 The current year will be entered if the year is missing.
0:00
20180420 4/20/2018
0:00
20180420 2:22:00 |4/20/2018
AM 0:00
4/9/2018 16:13 4/9/2018
16:13
4/9/2018 8:49 4/9/2018
8:49
9-Apr-18 4/9/2018
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Entry in Load File

Object

Definition

08:00

Type
0:00
Apr.9, 18 4/9/2018
0:00
4.9.2018 4/9/2018
0:00
49.18 4/9/2018
0:00
4/9/2018 4/9/2018
0:00
4;9;2018 4/9/2018
0:00
Wednesday, 09 4/9/2018
April 2018 0:00
12-31-1753 12/31/1753
12:00 AM
2014-11- 11/28/2014
28T17:45:39.744- | 0:00

4/9/18 13:30 PM

Results in an error

2018-044-09

Results in an error

4/9/2018 10:22:00
a.m.

Results in an error

00/00/0000

Results in an error unless the CreateErrorForlnvalidDate value is set to false in
the Relativity.Desktop.Client.exe.config file.

In addition, Relativity takes into account the regional settings of the SQL Server where the database resides. For

example, you may have an SQL Server residing in the UK that uses the date format DD/MM/YYYY, such as 4/9/2011.
When you access a workspace on a PC with UK regional settings, the date appears as 4/9/2011. When you access

the same workspace on a PC with US regional settings, the date appears as 9/4/2011.

3.6.2.5 Delimiters

During import, you can designate which delimiters are used in your load file. You can select each delimiter from the
ASCI| characters, 001 — 255.

The delimiter characters have the following functions:

e Column—separates load file columns

* Quote—marks the beginning and end of each load file field (also known as a text qualifier)

* Newline—marks the end of a line in any extracted or long text field

e Multi-value—separates distinct values in a column. This delimiter is only used when importing into a Relativity
multi-choice field.

* Nested-values—denotes the hierarchy of a choice. This delimiter is only used when importing into a Relativity
multi-choice field.

fHRelativity
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Note: For example, say a load file contained the following entry, and was being imported into a multi-choice
field: “Hot\Really Hot\Super Hot; Look at Later”

With the multi-value delimiter set as “;” and the nested value delimiter set as “\"”, the choices would appear in
Relativity as:

Hot
Really Hot
Super Hot
|:| en fuego
B =
[C]2FA} (Med Expert)
Look at Later

3.6.2.6 Default delimiters
If you generate your own load files, you may choose to use Relativity’s defaults:
e Column—Unicode 020 (ASCII 020 in the application)
* Quote—Unicode 254 (ASCII 254 in the application)
¢ Newline—Unicode 174 (ASCII 174 in the application)
e Multi-Value—Unicode 059 (ASCII 059 in the application)
¢ Nested Values—Unicode 092 (ASCII 092 in the application)

3.6.3 Image and extracted text files

Forimage imports, Relativity requires Opticon load files with ANSI/Western European encoding. This .opt text file
references the Control ID on a page level. The first page should match up to any data you intend to load. You can use
this same process for importing page-level extracted text.

Relativity does not support Unicode .opt files for image imports. When you have a Unicode .opt file, you must resave
this file in ANSI/Western European encoding.

You must convert images in unsupported formats using a third-party conversion tool before Relativity can successfully
upload them.

3.6.3.1 Image file formats
Relativity accepts only the following file types for image loads:
» Single page, Group IV TIFs (1 bit, B&W)
e Single page JPGs
Multi page TIFs and PDFs can be imported into the system, but you must load them as native files.
3.6.3.2 Load file format
The Opticon load file is a page level load file, with each line representing one image.
Below is a sample:

REL00001,RELO1,D:\IMAGES\001\RELO0001.TIF,Y,,,3
REL00002,REL01,D:\IMAGES\001\RELO0002.TIF,,,,
RELO0003,REL01,D:\IMAGES\001\RELO0003.TIF,,,,
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REL00004,REL01,D:\IMAGES\001\RELOO004.TIF,Y,,,2
RELO0005,REL01,D:\IMAGES\001\RELO000S5.TIF,,,,

The fields are, from left to right:

e Field One — (REL0O0001) — the page identifier

Field Two — (RELO1) — the volume identifier is not required.

e Field Three — (D\IMAGES\001\RELOOOO1.TIF) — a path to the image to be loaded

e Field Four — (Y)— Document marker — a “Y” indicates the start of a unique document.
e Field Five — (blank) — can be used to indicate folder

* Field Six — (blank) — can be used to indicate box

e Field Seven — (3) — often used to store page count, but unused in Relativity

3.6.3.3 Importing extracted text during an image load

You can also import extracted text during the image import process by setting an option in the Relativity Desktop
Client. For more information about importing extracted text during an image load, see Importing an image file in the
Relativity Desktop Client Guide.

No changes are needed in the Opticon load file. If the aforementioned setting is active, Relativity looks for page level
txt files named identical to their corresponding TIFs. For example:

% RELO00OL, TIF
| REL0OOD1 bt
[ RELO0002.TIF
.| REL00002 bt
% RELO0003.TIF
.| REL000O3 bt
% RELO0004. TIF
.| RELDOOO4 bt
% RELD000S. TIF
| RELDOODS bt

3.6.4 Processed data

Some data originates from client files and needs processing to extract the metadata. The following table shows the
delimiters that your internal processing software must use to present data as fields.

Value Character | ASCIl Number
Column 1 020
Quote b 254
Newline ® 174
Multi-Value |; 059
Nested Value |\ 092

You can provide this list to your vendor to help communicate the required delivery format for load files. The fielded
data should be delivered as delimited files with column or field names located in the first line.
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3.7 Importing document metadata, files, and extracted text

You can use a document-level load file to import document metadata, native files, and extracted text. For large data
sets, consider breaking the load file into smaller document counts. Use multiple computers and instances to load the
individual load files. It may be helpful to break up the types of information into distinct subgroups; such as load
metadata, natives, text, and images. Loading data in smaller amounts can assist with quality assurance. We
recommend having no more than four concurrent RDC imports running on the same server or in the same workspace.

In addition, you may see warning or errors during an import under the following conditions:

» Native file with 0 KB - The RDC imports native files with the size of 0 KB. In the RDC, the Warnings tab dis-
plays a message indicating that the file is empty and only metadata has been loaded for the record. In the
viewer, users see extracted text when it exists for the file. If the file has no extracted text, users see a blank
placeholder, and no image or viewer options are available. See Configuring the RDC on page 87.

» Long file path names - If the load file contains a field used to set the folder path on the folders browser, and
the field is longer than 255 characters for a document, the RDC displays an error message for that document on
the Errors tab. The RDC doesn'timport the document into Relativity. The RDC continues to import any other
documents in the load file with fields shorter than 255 characters.

3.7.1 Importing RDC Permissions

The following permissions are required to use the importing feature in Relativity Desktop Client:

Object Security Tab Visibility Admin Operations
¢ Document: View, e Documents e Allow Import
Add, Edit

Note: You must also be part of a group that has access to the parent folder of the workspace or you will receive an
error when selecting that workspace in the RDC.

3.7.2 Importing documents
Use the following steps to import documents:
1. Open the RDC and select a workspace.

2. Onthe Tools menu, point to Import and then click Document Load File. (In the RDC browser, you can right-
click on a specific folder, point to Import and click Load File.) The Load File tab in the Import Document Load
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File window appears.

P =
| Relativity Desktop Client E=REGR

Eile | Tools i Opticns Help

Docums Import Image Load File... Crl+] ;I

=3 Export  » Document Lead File.., Ctrl+L
Production Load File... Ctrl+P

3. (Optional) To use settings in from an existing import file, use these steps:
a. Onthe Import Document Load File dialog, click the File menu, and select Load Import Settings.

b. Browse for your load field map file (.kwe) in the Open Saved Field Map dialog, and then click Open.

c. Click OK on the kCura.EDDS.WinForm dialog. Click Open on Choose Load File dialog. Settings from
the file are used to populate fields in the Load File and Field Map tabs. (You can also modify any settings
on these tabs as necessary.)

d. Continue with step 7.

4. Click;| to browse for a document load file on the Load File tab. Set the other options as necessary.
On the Load File tab, set the following options to indicate how your load file is configured:

e First line contains column names — select this option if your load file has a header.

-
4 Relativity Desktop Client | Import Document Load File

File Import
Import Destination
“Salt vs. Peppert,

Load File | Field Map

Load File
’]C:"-.Llsers"-mlinderrnan"-.DUcuments"-—.Misc Docs"RCA Info'\Loading Exercise*Loading Exercise"\Basic Load"Basic Data Load_export dat |
¥ First line contains column names [ File Column Headers
3 - Author (2)
Start Line Iﬂ j BCC (3)
Filz Encoding CCi4)
Control Mumber (1)
IWestem European {‘Mndcll _Iil Custodian (5)
N Date Received (7)
Characters Date Sert (5)
Column Email Subject (8)
Extracted Text (20)
| 91 (Ascil:oz20) =l FILE_PATH (21)
Filename (%)
Quote Filetype (10)
Folder Path (12)
|b (scil:254) =l From (1)
. Group ldentifier (13)
DI lssue (14)
® (ASCI:174) - lssue2 (15)
I _I Parent Date (16)
Multi-Yal Source File (19)
S Subject (17)
I: (ASCI-055) j To (18)
MNested Value
|\ (ASCI092) B
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e Start Line - select the line number in the load file where you want the import process to begin. The
default value is 0, which results in loading the entire file.

* File Encoding - select an encoding for the document load file. (Consult your processing vendor or
department to determine the correct encoding option, if necessary.) If your file contains a language other
7
than English, choose a Unicode option. CIickm for additional options or click ‘-I
ation about encoding.

5! Pick Encoding EI@

for additional inform-

Arabic [B64)

Arabic (450 708

Arabic (DOS)

Arabic [150]

Arabic [Mac]

Arabic Pwindows)

Baltic (D05)

Baltic [150]

Baltic M indows)

Central European [DO5]
Central European [150]
Central European [Mac)
Central European [wWindows]
Chinese Simplified [ELIC)
Chireze Simplified [GB18030]
Chireze Simplified [GB2312) ¥

ok Cancel 1

m

Review the following information about how the encoding of load files is handled:

» Relativity uses auto-detection to determine the encoding of your text files. If it finds a different file
type in your text files, it changes to the appropriate method.

» Relativity immediately applies any changes that you make to the encoding of a load file, and dis-
plays these changes in the column header preview.

 Relativity provides you with the ability to audit the encoding of a load file.

¢ Relativity includes the functionality for previewing the import file as well as the encoding of the
extracted text files.

e File Column Headers - Relativity automatically updates this section of the Load File tab when you select
the file encoding. This section may display the following message before you select an encoding for the
load file.

“File Calurn Headers

The encoding of the selected load file could not be detected, Please select the load file's encoding.

After you select the encoding, this section displays the fields in the load file. The column headers in the
file display as vertical list. The fields display in alphanumeric order. The numeric value in parentheses
indicates the position of the field within the file. For example, the control number is the first column in this
illustration, while the Application Name is second.
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—File Calurmn Headers ———

Application Mame [2]
Attachment [3]
Attachment Parent 1D [4]
Auathor [3)

BLCC [R)

CC[7)

Control Humber [1]
Corveersation [3]
Corvversation Family [3]
Corverzation [0 [10]
Custodian [171]

Date Created [12]
Date Lazt Madified [13]
Date Received [14]
Date Sent [15]

Email Subject [16]
Ewtracted Test [17]

Since the load file is parsed based on the delimiter set, you may need to check delimiters used in the load
file if the column headers are not lined up correctly. Determine the delimiters used in the file, and then
select them in the Character section of this tab.

e Characters - select the delimiters used by your load file:
¢ Column delimiter - select the character used to separate columns.

e Quote - select the character used as the text qualifier.

¢ Newline - select the character used to indicate the end of a line in any extracted text or long text
field.

e Multi-value delimiter - select the character used to separate choices within a field.

e Nested value - select the character used to separate the different levels of a multi-choice hier-
archy.
For example, you might import a field with following values: “Hot\Really Hot\Super Hot; Look at
Later”. Using a semi-colon (;) as a multi-value delimiter, and a backslash (\) as a nested value
delimiter, Relativity displays the choices as illustrated below:

¥| Hot
Really Hot
Super Hot
|:| en fuego
=
7] 2FAL (med Expert)
¥ Look at Later

5. Click the Field Map tab. To automatically map fields, click Auto Map Fields below the lists of fields. The fields
from the load file are mapped to any existing fields of the same name in the workspace.

Desktop Client Guide



Load File Field Map

Waorkspace Fields Load File Field=s
I Fier I Fifer I Fiter I Fifer

Entity Recipient - Author s Author (4) A

Entity To Control Number [Identifie Control Mumber (2)

ETHD Conversation Conversation (5)

Excel Hidden Columns

Custodian Custodian (7) 33 |
Excel Hidden Rows

Email BCC Email BCC (13)

had
Excel Hidden Worksheet Email CC Email CC (14)
Excel Pivot Tables = | Email From | 4+ Email From (15) = |
Extracted Text Size in Kl Email Subject Email Subject (16)
Family Group Ll Email To 4| & ||Email To (17) Ll
File Extensian Bxtracted Text Extracted Text (18)
File Type MD5 Hash MOS Hash (23)
Has Hidden Data €€ | MNumber of Attachments number of attachments (i €€ |
Has OCR Text Parent Document 1D Parent Document 1D (25)
Image Taken DateTime Title Title (27)
Imaging Set File Name Filename [15)
Immninn Warninn ~ B w7 Eilacize (1 v
£ > £ > £ > £ >

Only fields matched in the center columns are loaded into the workspace. Other fields in the Workspace Fields
and Load File Fields lists are ignored. You must always match the identifier field for the load file.

Consider the following when auto-mapping fields:

e Case isn't taken into account for the mapping. For example, a field named "email" in the load file would
map to a field named "Email" in the workspace.

e Spacing is taken into account. For example, in a two-word field name, if there is one space between
words in the workspace field, and two spaces between words in the load file field, the fields will not be
mapped.

e Characters are mapped only to themselves. For example, an underscore is only mapped to another
underscore, not to a space.

Note: You can also manually map fields in the load file to existing fields in the workspace.

To manually map fields, highlight a field from the Workspace Fields list and click the right arrow to move the
field into the center column. Then, highlight the corresponding field in the Load File Fields list and click the left
arrow to move the field into the center column. You can move all fields in a list into a new column by clicking
the double arrow buttons. Use the up and down arrow buttons to reorder the fields.

Review these additional guidelines when you map fields for a workspace and load file:

e Before importing relational fields, review the Import Behavior option on the New or Edit Field form. You
can use this option to determine how blank values are handled in relational fields.

« If you are importing a field that contains more than 200 choices, you will see these choices automatically
displayed in a Popup Picker. You will see an error if duplicate choices exist for the field.

Overwrite and Overlay identifiers:
In the Overwrite section, select one of these options to indicate the type of load:
e Append Only - loads only new records.

e Overlay Only - updates existing records only. You must include an Overlay Identifier in an overlay
load. This field acts as a link indicating to Relativity where to import the data.

* Append/Overlay - adds new records and overlays data on existing records
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If you are performing an overlay or append/overlay, select an Overlay Identifier to specify the field that links
your overlay load file to the workspace.

Note: The fields in the drop-down menu are fixed-length fields with a manually-applied SQL index. This is
NOT the same as adding the field to the full-text index. Contact your SQL database administrator to apply an
index to a field.

Multi-Select Field Overlay Behavior:

The following fields are only available if you select the Append / Overlay or Overlay only Overwrite option:

¢ Merge Values - merges all values for multi-choice and multi-object fields in the load file with cor-
responding multi-choice and multi-option fields in the workspace. The fields are merged regardless of the
overlay behavior settings in the environment.

* Replace Values - replaces all values for multi-choice and multi-object fields in the load file with cor-
responding multi-choice and multi-option fields in the workspace. The fields are merged regardless of the
overlay behavior settings in the environment.

e Use Field Settings - merges or replaces all values for multi-choice and multi-object fields in the load file
with corresponding multi-choice and multi-option fields in the workspace. The fields are merged accord-
ing to the overlay behavior settings in the environment.

Folder Info:

In the Folder Info section, select Folder Information Column if you want to use a metadata field to build the
folder structure for the workspace. In the drop-down box, choose the field that you want Relativity to use for
building the folder structure. This field is commonly a source or folder path field. All folders are built under the
Import Destination folder.

When building the folder structure, Relativity looks for backslashes to indicate a new sub-folder. The following
folder structure would result from a field containing field with the value UB Impairment\Accounts\Bunk
Accounts:

SR UB Impairment
-y Accounts
("] Bunk Accounts

Before importing, you can use the Preview Choices and Folders option to check the number of choices and
folders created by importing the records to the workspace.

Note: The number of folders reported during preview is inaccurate if the folder name contains a backslash.
Avoid using backslashes in folder names.

Note: Do not select Folder Information Column if you do not want to build a folder structure based on
metadata. When this option is not selected, Relativity loads all documents directly into the folder indicated by
the import destination.

Parent Info:

The Parent Info section will display instead of the Folder info section if you are importing an object or objects
that are children of other objects such as Search Terms Results. If desired, you can check Parent Information
Column and select an object from the drop-down list to determine which parent object you would like to map it
to. Alternatively, you can leave this option unchecked if you do not wish to map the object with a parent object.

Desktop Client Guide



Note: The Parent Information Column can only be unchecked if Overlay only is selected in the Overwrite
section.

Native File Behavior:

In the Native File Behavior section, select Load Native Files if you want to load native files along with database
records. (Do not select this option if you do not have any native files to load.)

In the Native file paths contained in column drop-down box, select a field from your load file that contains a
relative or absolute path to the native files. If the native files reside in a Relativity-accessible location, click
Repository, and select one of these options:

e Copy files from current location to selected document repository - select this option to copy files
from the location in the selected load file field to the selected document repository.

Note: You can use the Default option to configure an environment level. See the
CopyFilesToRepository instance setting.

['—|_— File Repository Preferences x

¥ Copy files from current location to selected document repository

Document Repositony

Wiles 101 9.ctus014128 11 keura.com TO1 3 Files™. jl Default I
Repository settings cannot be changed when ROC runs in Aspera mode. Click to read more.

ok | Cancel |

e Do not copy files to a Relativity document repository - select this option if the native files have
already been copied to their final location, which is accessible by Relativity.

Note: Selecting this option causes the transfer mode to display as disabled.

Extracted Text:

In the Extracted Text section, set the following options to control how the Full Text or OCR is loaded into the
database. You can import full text or OCR into any long-text field that has been mapped. These options are only
available for selection if you've already mapped a long-text field:

e Cell contains file location- select this option if your extracted text is in document-level text files, and
your load file contains a path to those text files. You don't need to select this option if a field in your load
file contains extracted text.

: Encoding for undetectable files- select an encoding for the text file. Click for additional language

7

* Western European (Windows)- indicates the Windows standard encoding for English.

options or click = for additional information about encoding.

* Unicode - utilizes more than 107,000 characters covering 90 scripts.

* Unicode (Big-Endian)- is the same as Unicode, except that the byte order is reversed.
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¢ Unicode (UTF-7)- represents Unicode text using a stream of ASCII characters to guarantee that
the high bit will always be zero.

« Unicode (UTF-8)- represents all characters in the Unicode character set using 8-bit bytes.

Note: A warning message appears if you are missing information required to run the import.
Update the settings for the required options, and click Import File again.

6. (Optional) To preview information about the content you are importing to the workspace, select Import, and
click one of these options:

e Preview File - displays the first 1000 documents in the load file. Only mapped fields appear. Make sure
that matched fields that appear in the preview are correct.

Relativity Desktop Client | Preview Load File (== =]

Record Mumb | 1:Contral Mumnber | 1:Date Atk BCC | Extracted Text Cusgtodian_+
r | alewis_D013010 20010601 175600000 ' from:_ puthigai savita  [new code;
2 azipper_0000050 20010529 13:06:00.000 leI‘IIT .io_hln:son @EIam [Few code’
3 azipper_0000051 ENran broker deal summary [hew code’
4 azipper_0000053 20010530 18:44:00.000 leI‘IIT io_hpson ‘?_Elam [hew code’
| [} azipper_0000054 ERran broker d;al summary [hew code’
.B azipper_0000055 20010531 18:43:00.000 leI‘IIT io_hpson ‘?Elam . [hew code’
7 azipper_0000056 ENran broker dPaI summary [hew code’
a azipper_0000058 20010607 18:23:00.000 leI‘IIT io_hpson ‘?Elam . [hew code’
9 azipper_0000059 Eran broker d?al summary [hew code’
.10 azipper_00000E0 2001 0606 1:50;00.000 flOI‘IIT io_hpson ‘?_th:lam . [hew code’
| " azipper_00000E1 Eran broker dgal summary [hew code’
.12 azipper_0000036 20010418 11:28:00.000 flom:_forlsterl dalvid o [hew code’
| 13 azipper_0000087 20010418 16:23:00.000 frolm: : flo'rste.,r ;I_:avid [hew code’
|14 avipper_DOND0SS 20010418 16:35:00.000 from: ferster david [new code!
|15 azipper_0000083 mrmotgin totlals yr 2ﬁDDﬁ [new code]
.18 azipper_0000312 2001 0430 20:05:00.000 fr_om:_ mostant justin [rew code’
|17 azipper_0000437 2001 0530 201 300,000 from: shits beb [new code;
118 azipper_0000435 20010531 0%:57.00.000 from: forster david [new code:
19 azipper_0000433 20010531 10:00:00.000 from: ferster david [new code:
20 azipper_00DDSDN 20010531 10:31:00.000 from: cummings john  [new code
| il azipper_0000R02 jcurnrnin shéeﬂ - [Few code’
.22 azipper_0000504 20010531 18:42:00.000 frorg: I?aney J_n:uike [Few code’
| 23 azipper_0000R05 mike haney &a &a La &a metals & [Few code’
.24 azipper_0000ET7 20010413 16:29:00.000 fl_om:_ rostant iﬁustin [Few code’

N |25 aziooer DO 20010417 13:50:00.000 from: rostant. iustin inew o~

* Preview Errors - checks all documents for potential loading errors, but displays only the first 1000
errors. If your file does not contain errors, a no errors message appears.

Note: You can use the error report to correct any errors, and then you can re-add the file to the RDC.
Relativity only loads valid records. Records with errors are skipped. You can export the records for
correction and reload. See Handling errors on page 16.

* Preview Choices and Folders - displays the number of choices created in the browser and the number
of choices created by importing the records.

7. On the Import menu, click Import File.

Note: If Force folder preview is selected, a confirmation message appears, which contains information
about the number of folders that will be created. Click OK to continue with the import.

8. Review the progress of the import.
You can view the progress of an import through the RDC. Select the following tabs to display specific
information:
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« Summary - displays general information about the number of records, processing warnings, and errors.
The following screen shot displays file progress for an import job.

|_'-|_-| Import Load File Progress ... —

33
End upload T3562a1b-2353-450e-a2h1-51cbb183520e’ file. (778ms) [line 85]

89 of 686 processed

Summary I Errors I Progress I Wamings I Report I

Start Time: 2:53:08 PM
Duration: 00:00:14

Time Left to Completion: 00:01:40

Total Becords: &8&

Total Processed: 28

Total Processed w/Warnings: 0
Total Processed w/Errors: 0

Average file tramsfer rate: 777.20 EB/sec
Current batch size: 1,000

File Transfer Mode: Aspera, Metadata: Pending

o Errors - lists any errors encountered during the load. The Errors tab displays any errors that occur when
you import content with the RDC.

Note: When you run an import job, the RDC only imports records with no errors into the workspace.

» Progress - displays a detailed view of the load progress.
o Warnings - displays information about loading or connection issues.

o Report - includes the following files that you can export:
o Export Error Report - exports a .csv file with a summary of errors.

« Export Error File - exports a .dat file, which is a document-level load file containing only records
with errors.

o File Transfer Mode - displays the following information:
o Web mode - this mode uses the web server and it is the standard.
« Direct mode - this mode provides faster performance, but requires a connection to the network

hosting the data, as well as specific Windows group permissions. For more information, see Direct
mode on page 10.
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9. (Optional) To save your import settings, point to the File menu, and then click Save Import Settings. Choose a
location for the document load file (.kwe). See Saving import settings on page 17.

3.7.3 Importing Yes/No fields on documents
To ensure that you get the correct results when importing into Yes/No fields, use these guidelines:

* No values — Import Yes/No fields containing any values except those specified for Yes values.

* Yes values — Import Yes/No fields containing only "Yes", "Y", "True", "T", and any non-zero integer. (For
example, if you import an "X", the RDC assigns a value of "No" to the documents.)

e Null values — Leave the Yes/No field empty.

Note: You can change the display values on a Yes/No field, but your modification doesn’t affect how the RDC
handles these values during a document import.

3.7.4 Stopping an import or export job
To stop an import or export job in the RDC, click Stop on the import load file progress window.

L Import Load File Progress ...

522
End upload "1d736d7-d142-4dcc-30bd-e2c61b6056585" file. (279ms) [line 522]

522 of 686 processed /

Summary I Emars | Progress I Wamings I Report |

Start Time: 4:18:42 PM
Duration: 00:00:1e

Time Left to Completion: 00:00:05

Total Records: €8¢

Total Processed: 522

Total Processed w/Warnings: 0
Total Processed w/Errors: 0

Liyerage file transfer rate: 1.3%2 ME/sec
Current batch size: 1,000

File Transfer Mode: Aspera, Metadata: Pending

Once you click Stop, note that the Progress tab displays the following status messages:
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e Job has been stopped — X documents have been transferred.
¢ Finalizing job...

* Job has been finalized.

Note: Between Finalizing job and Job has been finalized, you could see a variety of job-specific messages, such
as Native file uploads completed.

When you stop a job, only the files from the last configured batch are imported/exported, and the progress bar is
reverted to display this.

For example, when you clicked Stop, the window displayed that 331 out of 371 files had been processed up to that
point; however, because you configured the batch size in the config file to be 10MB, only 263 documents were actually
processed because the metadata size for 263 docs is 10MB. Accordingly, the progress window then displayed a
message of Process stopped by user with a processed count of 263 of 371.

|_';| Import Load File Progress .., —

I Process stopped by userl
End upload "1d75f6d7-d142-4dec-90b4d-e 20610605985 file. (279ms) [line 522]

522 of 686 processed

Summary I Emaors | Progress I Wamings I Report |

Start Time: 4:15:42 BM
Curation: 00:00:1&

Time Left to Completion: 00:00:05

Total Records: &2c

Total Processed: 522

Total Processed w/Warnings: 0O
Total Processed w/Errors: 0O

Average file transfer rate: 1.3% MBE/sec
Current batch si=ze: 1,000

File Transfer Mode: Aspera, Metadata: Pending

3.8 Importing an image file

You can import image load files that are Opticon-formatted page-level files. Relativity only accepts single page, Group
IV TIFs, or JPGs.
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3.8.1 Importing RDC Permissions

The following permissions are required to use the importing feature in Relativity Desktop Client:

Object Security Tab Visibility Admin Operations
e Document: View, e Documents e Allow Import
Add, Edit

3.8.2 Importing images

To import an image load file:

1. Open the RDC and select a workspace.

2. Onthe Tools menu, point to Import and then click Image Load File. (In the RDC browser, you can right-click
on a specific folder, point to Import and click Image File.) The Import Production Load File dialog appears.

> 5
/| Relativity Desktop Client E=REER

File | Tools I Options Help

Diocume Import Image Load File... Ctrl+I ;I

=3 Export r Document Load File... Ctrl+L
Production Load File... Cirl+P

3. (Optional) To use settings in an existing import file, complete these steps:
a. Onthe Import Image Load File dialog, click the Import menu, and then select Load Settings.

b. Browse for your load settings file (.kwi) in the Open dialog, and then click Open.

Note: The RDC denotes all image and production import settings with a .kwi file extension. However,
when you select these file types to filter on when you're choosing to save or load the settings file, the
RDC denotes these settings with a .kwx file extension.

c. Click OK on the kCura.EDDS.WinForm dialog. Click Open on Choose Load File dialog. Settings from
the file are used to populate fields in the Import Image Load File dialog. (You can also modify the settings
on this dialog as necessary.)

d. Continue with step 5.

4. Onthe Import Image Load File dialog, set the options as necessary. Select the following options:

* Load File - cIickm to browse for your page-level load file. Relativity accepts Opticon format image load
files.
« Start Line - select the line number in the load file where you want the import process to begin. The
default value is 0, which results in loading the entire file.
¢ Numbering - select one of the following options:
e Use load file page IDs - default setting.
¢ Auto-number pages - select this option if page IDs in the production are not unique. For example,

you might import a set of TIFFs that share a page identifier for each record. The page identifiers
are shared per document and are not unique. The Auto-number pages option appends the 01,
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.02, and so on to the page-level identifier, creating a unique number per page.

100001,,D:\IMAGES\001\,100001_00L.TIF.Y,,,3
100001,,D-\ IMAGES\001\100001_002.TIF,,,,
100001,,D\ IMAGES\001\100001_003.TIF,,,,
100002,,D-\ IMAGES\001\100002_001.TIF,Y,, 2
100002,,D\ IMAGES\001\100002_002.TIF,,,,

Note: Enable Auto-number pages if you are importing productions that use document level
numbering without page numbers, and include documents that contain multiple pages.

o Select Mode - select one of the following options:
e Append Only - load only new records.

e Overlay Only - update existing records only. You must include a workspace identifier in an over-
lay load. This field acts as a link indicating to Relativity where to import the data.

e Append/Overlay - adds new records and overlays data on existing records.

Note: Select Append to import the extracted text and natives from a .dat file. Select overlay when
overlaying production images onto the existing documents.

e (Available Only for Production Load Files) Production - select a Relativity production that you want to
upload images to. Only new production sets without a production source appear in this list.

» (Available Only for Production Load Files) Overlay Identifier - select a field that stores overlaid doc-
ument-level Bates information on the document.

Note: The fields in the drop-down menu are fixed-length fields with a manually-applied SQL index.

Note that this is NOT the same as adding the field to the full-text index. Contact your SQL database
administrator to apply an index to a field.

* Repository - if the native files reside in a Relativity-accessible location, click Repository, and select one
of the following options. (You can ignore this option if your files are on your desktop or laptop, or if you are
a consulting partner loading data into our hosting environment.)

e Copy files from current location to selected document repository - select this option to copy
files from the location in the selected load file field to the selected document repository.

Note: You can use the Default option to configure an environment level. See the Instance
setting guide.
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['—T— File Repository Preferences x

¥ Copy files from current location to selected document repository

Document Repository

Wiles 1019 ctus014128 r1 keura.com™TO19\Fles'. LI Diefault I

Bepository settings cannot be changed when ROC runs in Aspera mode. Click to read more.

ok | Cancel |

* Do not copy files to a Relativity document repository - select this option if the native files have
already been copied to their final location, which is accessible by Relativity.

Note: Selecting this option causes the transfer mode to display as disabled.

e (Available Only for Image Load Files) Load Extracted Text - select this option to load new text for Pro-
duction documents that may be revised based on redactions. The text files must be meet these require-
ments:

e Have .txt extensions
e Stored in the same directory as TIFF files,

¢ Named in the same way as the TIFF files

e (Available Only for Image Load Files) Encoding for undetectable files - select an encoding for the text
A

e Western European (Windows) - indicates the Windows standard encoding for English.

file. Click m for additional language options or click = for additional information about encoding.

e Unicode - utilizes more than 107,000 characters covering 90 scripts.
* Unicode (Big-Endian) - is the same as Unicode, except that the byte order is reversed.

e Unicode (UTF-7) - represents Unicode text using a stream of ASCII characters to guarantee that
the high bit will always be zero.

¢ Unicode (UTF-8) - represents all characters in the Unicode character set using 8-bit bytes.

. (Optional) To view any errors, click Import, and then select Check Errors. The preview dialog lists several tabs
that may contain information about any errors in your import. See Handling errors on page 16.

Click Import File on the Import menu.

. Review the progress of the import.
You can view the progress of an import through the RDC. Select the following tabs to display specific
information:

o Summary - displays general information about the number of records, processing warnings, and errors.
The following screen shot displays file progress for an import job.
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|_'-|_-| Import Load File Progress ... —

a3
End upload f3962a1b-8393-459e-a2b1-51cbb 183520 file. (778ms) [line 29]

89 of 686 processed

Summary I Errors I Progress I Wamings I Report I

Start Time: 2:53:08 PM
Duration: 00:00:14

Time Left to Completion: 00:01:40

Total Records: &8&

Total Processed: 28

Total Processed w/Warnings: 0
Total Processed w/Errors: 0

Average file tramsfer rate: 777.20 EB/sec
Current batch size: 1,000

File Transfer Mode: Aspera, Metadata: Pending

Errors - lists any errors encountered during the load. The Errors tab displays any errors that occur when
you import content with the RDC.

Note: When you run an import job, the RDC only imports records with no errors into the workspace.

Progress - displays a detailed view of the load progress.
Warnings - displays information about loading or connection issues.

Report - includes the following files that you can export:
o Export Error Report - exports a .csv file with a summary of errors.

o Export Error File - exports a .dat file, which is a document-level load file containing only records
with errors.

File Transfer Mode - displays the following information:
« Web mode - this mode uses the web server and it is the standard.
« Direct mode - this mode provides faster performance, but requires a connection to the network
hosting the data, as well as specific Windows group permissions. For more information, see Direct
mode on page 10.

. (Optional) To save your import settings, point to the File menu, and then click Save Import Settings. Choose a
location for the production load file (.kwi). See Saving import settings on page 17.
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3.9

Importing a production file

You can import external productions into Relativity through the Relativity Desktop Client.

This

is useful when a case team, after a production goes out the door, needs access to documents as they were in the

production and needs them available for searching.

3.9.

1 Special considerations

Follow these guidelines when you want to work with externally created production:

Create a production set in Relativity. The numbering imported with the Opticon file functions as sequential
Bates numbering. (The Bates label setting in the imported production is not used.)
Run the production with the external tool to generate the following files:

« Document level control file - it should minimally contain an identifier field that is also present in the
workspace, and a new production or Bates number.

Note: When loading a production set into Relativity, you may map a production numbering field to the
identifier field, as long as it is unique.

* Page level Opticon file - it should use the production or Bates numbering scheme.

Overlay document level load file in Relativity.

Loading documents into a 'staging' production marks the production set as produced.

When loading a production set into Relativity, the systems loads the newly created documents into the root
folder. It may be prudent to move these documents to a new folder to ensure proper foldering and security of the
documents.

Using Append/Overlay during the metadata import creates new documents that did not have images, but these
documents aren't associated with the production. To associate these files with a production set, create and load
an image load file pointing to placeholder images and then overlay the metadata. Using the Overlay Only option
shows an error on any document not already loaded, and you can use the error file as a list to identify doc-
uments that may not have had images.

3.9.2 Importing RDC Permissions

The following permissions are required to use the importing feature in Relativity Desktop Client:

Object Security Tab Visibility Admin Operations
¢ Document: View, o Documents e Allow Import
Add, Edit

3.9.

3 Importing a production

To import a production, use these steps:

1.
2.

Open the RDC and select a workspace.

On the Tools menu, point to Import, and then click Production Load File. (In the RDC browser, you can right-
click on a specific folder, point to Import and click Production File.) The Import Production Load File dialog
appears.
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> 5
Relativity Desktop. Clieal o o 0
ty Desktop

Eile | Tools I Options Help

Diocume Import Image Load File... Ctrl+I ;I

=3 Export r Document Load File... Ctrl+L
Production Load File... Cirl+P

3. (Optional) To use settings in an existing import file, complete these steps:
a. Onthe Import Production Load File dialog, click the Import menu, and then select Load Settings.

b. Browse for your load settings file (.kwi) in the Open dialog, and then click Open.

Note: The RDC denotes all image and production import settings with a .kwi file extension. However,
when you select these file types to filter on when you're choosing to save or load the settings file, the
RDC denotes these settings with a .kwx file extension.

c. Click OK on the kCura.EDDS.WinForm dialog. Click Open on Choose Load File dialog. Settings from
the file are used to populate fields in the Import Production Load File dialog. (You can also modify the set-
tings on this dialog as necessary.)

d. Continue with step 5.

4. On the Import Production Load File dialog, set the options as necessary.

* Load File - cIickm to browse for your page-level load file. Relativity accepts Opticon format image load
files.

« Start Line - select the line number in the load file where you want the import process to begin. The
default value is 0, which results in loading the entire file.

* Numbering - select one of the following options:
e Use load file page IDs - default setting.

¢ Auto-number pages - select this option if page IDs in the production are not unique. For example,
you might import a set of TIFFs that share a page identifier for each record. The page identifiers
are shared per document and are not unique. The Auto-number pages option appends the 01,
.02, and so on to the page-level identifier, creating a unique number per page.

100001,,D:\IMAGES\001\,100001_00L.TIF,Y,,,3
100001,,D:\ IMAGES\001\100001_002.TIF,,,,
100001,,D\ IMAGES\001\100001_003.TIF,,,,
100002,,D\ IMAGES\001\100002_001.TIF,Y,, 2
100002,,D-\ IMAGES\001\100002_002.TIF,,,,

Note: Enable Auto-number pages if you are importing productions that use document level
numbering without page numbers, and include documents that contain multiple pages.
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» Select Mode - select one of the following options:
e Append Only - load only new records.

e Overlay Only - update existing records only. You must include a workspace identifier in an over-
lay load. This field acts as a link indicating to Relativity where to import the data.

e Append/Overlay - adds new records and overlays data on existing records.

Note: Select Append to import the extracted text and natives from a .dat file. Select overlay when
overlaying production images onto the existing documents.

e (Available Only for Production Load Files) Production - select a Relativity production that you want to
upload images to. Only new production sets without a production source appear in this list.

¢ (Available Only for Production Load Files) Overlay Identifier - select a field that stores overlaid doc-
ument-level Bates information on the document.

Note: The fields in the drop-down menu are fixed-length fields with a manually-applied SQL index.
Note that this is NOT the same as adding the field to the full-text index. Contact your SQL database
administrator to apply an index to a field.

e Repository - if the native files reside in a Relativity-accessible location, click Repository, and select one
of the following options. (You can ignore this option if your files are on your desktop or laptop, or if you are
a consulting partner loading data into our hosting environment.)

e Copy files from current location to selected document repository - select this option to copy
files from the location in the selected load file field to the selected document repository.

Note: You can use the Default option to configure an environment level. See the Instance
setting guide.

! File Repository Preferences *

% Copy files from current location to selected document repositony

Document Repository

Wifiles 1019 ctus014128 r1 kcura.com™TO15\Files™ ;I Default I
Repository settings cannot be changed when RDC runs in Aspera mode. Click to read more.

ok | Cancel |

* Do not copy files to a Relativity document repository - select this option if the native files have
already been copied to their final location, which is accessible by Relativity.

Note: Selecting this option causes the transfer mode to display as disabled.

e (Available Only for Image Load Files) Load Extracted Text - select this option to load new text for Pro-
duction documents that may be revised based on redactions. The text files must be meet these require-
ments:

¢ Have .txt extensions

e Stored in the same directory as TIFF files,
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e Named in the same way as the TIFF files

* (Available Only for Image Load Files) Encoding for undetectable files - select an encoding for the text
A

e Western European (Windows) - indicates the Windows standard encoding for English.

file. Click m for additional language options or click = for additional information about encoding.

e Unicode - utilizes more than 107,000 characters covering 90 scripts.
* Unicode (Big-Endian) - is the same as Unicode, except that the byte order is reversed.

e Unicode (UTF-7) - represents Unicode text using a stream of ASCII characters to guarantee that
the high bit will always be zero.

¢ Unicode (UTF-8) - represents all characters in the Unicode character set using 8-bit bytes.

. (Optional) To view any errors, click Import, and then select Check Errors. The preview dialog lists several tabs
that may contain information about any errors in your import. See Handling errors on page 16.

. Click Import File on the Import menu.

. Review the progress of the import.
You can view the progress of an import through the RDC. Select the following tabs to display specific
information:

o Summary - displays general information about the number of records, processing warnings, and errors.
The following screen shot displays file progress for an import job.
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|_'-|_-| Import Load File Progress ... —

a3
End upload f3962a1b-8393-459e-a2b1-51cbb 183520 file. (778ms) [line 29]

89 of 686 processed

Summary I Errors I Progress I Wamings I Report I

Start Time: 2:53:08 PM
Duration: 00:00:14

Time Left to Completion: 00:01:40

Total Records: &8&

Total Processed: 28

Total Processed w/Warnings: 0
Total Processed w/Errors: 0

Average file tramsfer rate: 777.20 EB/sec
Current batch size: 1,000

File Transfer Mode: Aspera, Metadata: Pending

Errors - lists any errors encountered during the load. The Errors tab displays any errors that occur when
you import content with the RDC.

Note: When you run an import job, the RDC only imports records with no errors into the workspace.

Progress - displays a detailed view of the load progress.
Warnings - displays information about loading or connection issues.

Report - includes the following files that you can export:
o Export Error Report - exports a .csv file with a summary of errors.

o Export Error File - exports a .dat file, which is a document-level load file containing only records
with errors.

File Transfer Mode - displays the following information:
« Web mode - this mode uses the web server and it is the standard.
« Direct mode - this mode provides faster performance, but requires a connection to the network
hosting the data, as well as specific Windows group permissions. For more information, see Direct
mode on page 10.

. (Optional) To save your import settings, point to the File menu, and then click Save Import Settings. Choose a
location for the production load file (.kwi). See Saving import settings on page 17.
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3.9.3.1 Saving the progress log

Once your import or export job is complete, you have the option of saving the event log from that job to your machine.
You can do so by clicking Save Progress Log on the progress window of the RDC.

% Import Load File Progress ... - O d

All records have been processed

ENERRNNNENNNNNENNNENNNENEN] _ coe

90000 of 30000 processed Hide Detail

Summary | Emors I Proaress I Wamingsl F{eportl

Start Time: 1:56:32 BM L
Finish Time: 2:01:31 EM

Duration: 00:04:58

Total Records: S0000

Total Processed: 30000

Total Processed w/Warnings: 0
Total Processed w/Errors: 0

Lo

Metadata: Direct - Files: not copied - SQL Insert Mode: Bulk Save Progress Log I

Note the following details:

e This log comes in the form of a temp folder containing all the messages displayed in the interface while the
import or export job was running.

e The option to save the progress log is only available if you've set the LogAllEvents value to True in the RDC con-
figuration file.

3.10 Import errors for Desktop Client

Note: When an item-level error occurs in a load file, Relativity Desktop Client uses the proper delimiter
automatically so that when users access the load file, they will not experience the error.

The following table lists the most common import errors found in the Relativity Desktop Client, including their
messages and fixes.

Message Fix
Invalid date. Change the date information to one of the standard date formats.
Invalid boolean. Change data to a YES or NO format.
Invalid decimal. Change the data to a valid number.
Invalid integer. Change the data to an integer.
Input length exceeds maximum set length of Increase the character restriction on the field.
<max length> for this VarChar field.
Input length exceeds maximum set length of Increase the character size of associated object.
<max length> for the associated object field
<name>.
Error uploading file. Skipping line. Verify and correct line information.
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Message

Fix

File upload failed. Either the access to the path
is denied or there is no disk space available.

Verify disk space is available and check permissions on data
server.

File '<file name>' not found.

Verify the file is available in path provided.

File '<file name>' contains 0 bytes.

No data exists in the file.

Identifier Value not set.

The Overlay Identifier field has not been mapped. Map the Over-
lay Identifier field.

Choice name specified twice for this record.

Two choice name fields are titled identically. Each choice name
should be unique from all others in the load file.

Proposed choice name exceeds 200 char-
acters.

Rename the specified choice to something less than 200 char-
acters.

User does not exist in the system or is not avail-
able for assignment.

Email used in the entity file is not associated with any entity in the
system.

Document has been previously processed in
this file

Same ID trying to load twice.

Error: full text file specified does not exist.

Verify the path of extracted text file.

There are an invalid number of cells in this row -
expecting:<expected>, actual:<actual>.

Remove the extra column delimiter from load file.

- This document identifier does not exist in the
system - no document to overwrite

Overlay unavailable. You must append the data.

A document with identifier <document identifier>
already exists in the system

The identifier field already exists in the system. You need to do an
overlay to overwrite the existing data.

This file identifier exists attached to another doc-
ument with selected key field {0}

Same ID trying to load twice.

This file identifier exists attached to another doc-
ument with selected ArtifactID {0}

Same ID trying to load twice.

This file identifier exists attached to another doc-
ument

Duplicate page ID in a different document.

Document is already in the selected production

The Bates number is already loaded.

Because you can't overlay into an existing production, you must
create a new production or replace the images manually on the
back end.

This document contains redactions or highlights
that can't be overwritten

Delete the markups.

There is no image specified on this line

Make sure image id is present in load file.

One of the files specified for this document does
not exist

Make sure image files are present for represented path.

The image file specified is not a supported
format in Relativity

This can't be loaded without conversion to an approved format.

HRelativity
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Message

Fix

The file being uploaded is empty

No data exists in the file so it can't be loaded.

The identifier field for this row is either empty or
unmapped

Verify that an identifier exists.

The identifier specified on this line has been pre-
viously specified in the file

Make sure the identifier field is unique or overlay data.

The document specified has been secured for
editing.

Change security permissions to allow document edit rights.

Your account does not have rights to add a doc-
ument or object to this case

Change security permissions to allow document add rights.

A non-unique associated object is specified for
this new object.

Two objects with the same name exist in the workspace. |dentify
the duplicates and change one of their names.

Your account does not have rights to add an
associated object to the current object.

Change security permissions to allow updates to object.

An object field references a child object which
does not exist.

Add a child object.

This record's Overlay |dentifier is shared by mul-
tiple documents in the case, and cannot be
imported.

Use a unique ID to overlay the data
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4 Exporting with the RDC

You can use the Relativity Desktop Client (RDC) to export production sets, saved search results, and folders. When
you perform an export, the RDC automatically creates top-level folders for images, text, and natives. The RDC exports
all documents included in the production set, search result, or folder.

. Production
L vOLoonoy
L IMAGES
. ImAGooOo0n1
. MWATIVES
L. MATIVEDDOOL
L TEXT
 TEXTOO0OL

Note: You need to install the RDC on your computer before you can perform an export.

4.1 Exporting RDC Permissions

The following permissions are required to use the exporting feature in Relativity Desktop Client:

Object Security Adml.n Oper-
ations
» Document: Local Access (Download, Copy Text) . Allow
Export

Note: This is required when exporting long-text cells greater than the value defined by the
MaximumLongTextSizeForExportinCell instance setting, the default value of which is 1048576.

4.2 Technical considerations for .kwx files

Note the following:

e _kwx stands for kCura Win edds eXport.
» The .kwx file you call on when you load export settings is a SOAP-serialized file used to run the export.

e SOAP is a protocol based on XML. It's designed specifically to transport or store procedure calls using XML. It
does this by converting fields and properties of an object into the serial format of an XML stream.

e When you run an export, the RDC collects all the inputs from the form into an object in memory. The RDC also
passes the object on to the export process.

¢ When you save an export settings object, Relativity passes that object in memory to a SOAP serializer. The
SOAP serializer writes that object’s settings to XML.

e When you load export settings, Relativity takes a serialized object and deserializes it to an in-memory settings
object. Then it loops over all the properties and sets the actual form values to reflect those settings.
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4.3 Exporting a production set

You can export the contents of a production set created in Relativity through the RDC.

4.3.1 Exporting RDC Permissions

The following permissions are required to use the exporting feature in Relativity Desktop Client:

Object Security Adml.n Oper-
ations
» Document: Local Access (Download, Copy Text) .« Allow
Export

Note: This is required when exporting long-text cells greater than the value defined by the
MaximumLongTextSizeForExportinCell instance setting, the default value of which is 1048576.

4.3.2 Exporting a production set

To export a production set:

1. Open the RDC and select a workspace.

2. Onthe Tools menu, point to Export and then click Production Set.

The Data Source tab in the Export Production window appears.

Opticns Help

Import  » |
Export Production Set...

Saved Search...

Folder...

Folder and Subfolders...

3. (Optional) To use settings in an existing export file, use these steps:
a. Click the File menu, and select Load Export Settings.

b. Browse for your export settings file (.kwx) in the Open dialog.

c. Select a production set, and click OK. Your production set appears on the Data Source tab, and the set-
tings from the file populate the Destination Files tab. (You can also modify any settings on the Data
Source and Destination Files tab as necessary.)

Note: On the Destination Files tab, you may want to select Overwrite Files if you're re-exporting the
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same group of files to the previously used location.

! Relativity Desktop Client | Select Production &5 |

MName |

anu
Mot run

Patert Production 1a
Patent Production 2
Patent Production 3
Patent Production 4
Patent Production 5

Patent Production Set 1

Patent Production Set 10

Patent Production Set 8
Patent Production Set 8 (1)

d. Continue with step 7.

4. Onthe Data Source, select a production set in the Productions box. Update the remaining options as neces-
sary.

The Data Source tab appears when you select the option to export production sets, saved searches, folders,
and subfolders. Each of these have similar actions, but you may want to select different settings for them.

Note: The Production:: Begin Bates and Production:: End Bates reflective fields automatically populate in the
Selected Columns.
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Baich

Bach: Assignad To
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Baich: Stasus £}

Diate Last Modifed
[Duase Recatved
E-ﬁlf Sent

File Size -
'] m ¥

On the Data Source tab, you can set the following options for the data that you want to export:

» Views - select a view for the data that you want to export.

e Selected Columns - choose the fields that you want to export by moving them to the Selected
Columns box. The box on the right displays all available fields, but the RDC only exports the fields in the
Selected Columns box.

Note: If you select any reflected fields, only the value for the production you select displays.

o Start Export at Record # - select a record number that identifies the initial document for export. The
RDC begins by exporting the document with this record number and continues by exporting documents
with subsequent record numbers.

(Available only for Saved Searches, Folders, and Subfolders) Production Precedence - clickIZI to dis-
play the Pick Production Precedence dialog where you can select a group of produced documents for
export instead of the original images.
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" Original Images
' Produced Images
™ Include original images for documents that haven't been produced
Aozilable Productions Selected Productions
Acme Production
Prod 04

Prod 03
Prod 02

=3

l'.
v Ok

— _ Concel |
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e Select the images that you want to export:
e Original Images - only the original, non-produced images.

e Produced Images - a produced version of the images.

e Include original images... - original images for the documents that are not in a specified pro-
duction.

e Move the productions that you want exported to the Selected Productions box. To move productions
between columns, highlight them and click the Right or Left single or double arrows. Use the Up and
Down arrows to order the precedence of the fields.

Note: The RDC only produces one version of each document. The version of the document in the topmost
production exports first. If the document doesn't exist in the topmost production, Relativity checks for the
document in the second production and so on. If the document is not a part of any of the selected
productions, and Include original images ... is enabled, then the original document produces.

5. Select the Destination Files tab.
On the Destination tab, you can set options that control how the files in folders, searches, and production sets
are exported. The Export dialog displays this tab when you select an Export option from the Tools menu, or
when you right-click on a folder or workspace in the RDC. The Destination tab displays the same options when
you export files in folders, searches, or production sets.
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(5! Relativity Desktop Client | Export Saved Search - O x

File
Data Source  Destination Fils | h
—Export Location — Text and Mative File Names
|Select a folder ... | Named after: | Select.. ~| . |
[~ Overwrite Files [ Append criginal filename
—Physical File Export—— File Path - Image
¥ Copy Files From Repository % Use Relative Paths ¥ Export Images
Data File Format: | Select... -
—Velume Information ——— | T Use Absolute Paths I _I

I— File Type: | Select... -
Prefux: [VOL  Use Prefix I I _I
serz[] = #ofdgits[2 =] [

- : | ¥ ExportNative Files ¥ Export rendered PDF's
Max Size (MB): mﬂ] : Load File Characters
Column: |1 (ASCII:020) | | [ Metadata
[Etzsen i o Data File Format [Select .. =]
Image Prefix: [ING Quote:[p (ASCI254) -]
Data File Encoding: | Select... ~] -] 2]
Mative Prefix: INATI‘u’E Newline:l'iﬁ (ASCII174) ﬂ I Export Text Field as Files

Multi-Value: I . (ASCII-059)

Pdf Prefix: IF‘DF Text Preoedenne:l |
Mested Value: |% (ASCI1:092
St [1 = sofdigis[3 =1 || e[\ ( )

Max Files:|500 =

L

Text Prefix: [TEXT Text File Encoding: [Select _ = | 2]

L

¥ Export Multiple Choice Fields as Mested

Note: In the Text and Native File Name section, the Named after option is available only for Production Sets.

6. Complete the fields on the Destination Files tab. See Fields on the Destination Files tab on the next page.

7. After you select your export settings, select File and click Run.

Note: A warning message appears if you are missing information required to run the export. Update the
settings for the required options, and click Run again.

8. Review the progress of the export.

You can view the progress of an export through the RDC. Select the following tabs to display specific
information:

« Summary - displays general information about the number of records, processing warnings, and errors.
The following screen shot displays file progress for an export job.
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|_'-T-| Export Saved Search Progress .., —

161
ltem "AZIPPER_DO0VETE file T1f7fcad-fdfd-4430-a657-892e1b036ack’ processed. [line 162]

63 of 371 processed

Summary | Erors | Progress | Wamings | Report |

Start Time: 3:Z2&:5& EM
Duration: 00:00:11

Time Left to Completion: 00:00:54

Total Becords: 371

Total Processed: €3

Total Processed w/Warnings: 0
Total Processed w/Errors: 0

Average file transfer rate: 473.71 EB/sec
Current katch size: 1,000

Metadata: - Files: Direct - SOL Insert Mode: Bulk

o Errors - lists any errors encountered during the load. The Errors tab displays any errors that occur when
you export content with the RDC.

o Progress - displays a detailed view of the load progress.
« Warnings - displays information about loading or connection issues.

» Report - includes the following files that you can export:
o Export Error Report - exports a .csv file with a summary of errors.

o Export Error File - exports a .dat file, which is a document-level load file containing only records
with errors.

o File Transfer Mode - displays the following information:
» Web mode - this mode uses the web server and it is the standard.
« Direct mode - this mode provides faster performance, but requires a connection to the network

hosting the data, as well as specific Windows group permissions. For more information, see Direct
mode on page 10.

9. (Optional) To save your export settings, point to the File menu, and click Save Export Settings. Choose a loc-
ation for the export settings file (.kwx).

4.3.3 Fields on the Destination Files tab

The Destination Files tab contains the following sections with their respective fields:
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’ Export Location - select a target directory for exporting folders, searches, and production sets. Click

L

—to

browse for a location. Select Overwrite Files to overwrite any existing files of the same name in the target
export directory.

e Physical File Export - select the Copy Files From Repository option. This is the default option and copies
files from the file server to the specified export location. If you don't select Copy Files From Repository,
Relativity doesn't copy the files to the export location. Instead, the exported load files reference the repository
location of the files.

» Volume Information - controls the naming and size of the volume identifier. Set the following options in this
section:

Prefix - enter the alpha prefix for the volume identifier.

Start # - select the first number used for the numeric section of the volume identifier. Multiple volumes
increment numbers during export creating unique volume identifiers.

# of Digits - select the number of digits attached to the prefix. (For example, if you select 3, the outputis
VOLO001, VOL002, and so on.)

Max size - select the maximum size allowed for each volume in MBs.

¢ Subdirectory Information - controls the naming and size of volume subfolders. Set the following options in this
section:

Image Prefix - enter the alpha prefix for the subdirectory that stores exported images.

Native Prefix - enter the alpha prefix for the subdirectory that stores exported native files.
Text Prefix - enter the alpha prefix for the subdirectory that stores exported extracted text files.
Pdf Prefix - enter the alpha prefix for the subdirectory that stores exported extracted PDF files.
Start # - select the starting number for the subdirectories.

# of Digits - select the number of digits of the subdirectory prefix (For example, if you select 3, the output
is IMG001, IMG002, and so on.)

Max Files - select the number of files to store in each subdirectory.

 File Path - controls how the export path for the files is referenced. Select one of the following options:

Use absolute paths - paths to exported files are represented as absolute paths.
C:\ Desktop\VOLOO1\NATIVEOO1\AS000001.msg

Use relative paths - paths to exported files are represented as relative paths.
A\VOLOOT\NATIVEOO1\AS000001.msg

Use prefix - a prefix is added to the relative path, such as a CD drive letter.
D:\VOLOO1\NATIVEOO1\AS000001.msg

e Load File Characters - select the delimiters to use in a document-level load file when Data File Format in the
Metadata section is set to Custom. Select the following options as necessary:

Column - this delimiter separates columns in the load file.

Quote - this delimiter qualifies the text in each field of the load file.

Newline - this delimiter signifies the end of any extracted text or long text field in the load file.
Multi-Value - this delimiter separates different choices within a choice field.

Nested Value - this delimiter indicates the hierarchy of choices within a choice field.
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» Text and Native File Names - select the following options for naming exported native and extracted text files:

Note: The following field types are supported by this feature: Date, Decimal, Fixed-Length Text, Single
Choice, Whole Number, and Yes/No.

e (Available Only for Production Sets) Named after - select one of the following naming convention for exported

files:

« Identifier - select this option to name the files after the identifier for your workspace.

e Beginning production number - select this option to name the files after the production number. (This
number may be the Bates number for a production.)

e Custom - select this option to name the native and text files in an export by appending them with either a
control number or production begin bates and optionally, a field of your choice.
To select custom naming options for your exported native and text files, do the following:

1.

Select Custom from the Named after drop-down menu.

CIickII] to the right of the Named after drop-down menu.

Select either the control number or production begin bates naming option from the drop-down

menu.
-

Optionally, to append a field or custom text to the file name, click .
Select the desired spacing option from the _ (underscore) drop-down menu.

To either add custom text to the name or to add a field to the name, do the following:

e Toinclude custom text as part of the name, choose the Custom Text... option in the drop-
down menu and enter the desired custom text in the textbox underneath the Custom
Text... drop-down menu.

e Toinclude afield as part of the file names, select the desired field option from the Custom
Text... drop-down menu. If a field is empty in a workspace it will not display as part of the file
name even if selected from the Custom Text... drop-down menu.

Note: If a boolean field is selected, the name of the field will be displayed and not the
value. For example: JWOLFE_009_confidential-HAS IMAGES.

El

Optionally, to add an additional field or custom text after the previously selected options, click :
Select the desired spacing option from the _ (underscore) drop-down menu.

To either add additional custom text to the name or to add an additional field to the name, do the
following:

e Toinclude additional custom text as part of the name before a field, choose the Custom
Text... option in the drop-down menu and enter the desired custom text in the textbox under-
neath the Custom Text... drop-down menu.

e Toinclude an additional field as part of the name, select the desired field option from the
Custom Text... drop-down menu. If a field is empty in a workspace it will not display as part
of the file name even if selected from the Custom Text... drop-down menu.
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Note: If a boolean field is selected, the name of the field will be displayed and not the
value. For example: JWOLFE_009_confidential-HAS IMAGES.

10. Click Apply to save the current naming options.

Note: If afile is not found in any of the production sets, the name will revert to the control
number or production begin bates regardless of which naming options you have selected.

e Append original file - Select this option to append the original file name which is defined as the file name as it
was on disk to the end of the exported file name.

* Image - determines whether to include images in an export and sets the format of the load file. Set the following
options:
e Check Export Images - select this option to include images in the export. (You must set the Data File
Format and the File Type when you exportimages.)

» Data File Format - select one of these formats forimage-level load file:
e Opticon

* IPRO

* File Type - select one of these file types:
e Single-page TIF/JPG

e Multi-page TIF
 PDF
» Native - controls which files are exported by Relativity Desktop Client.
e Export Native Files - select to export native files.

e Export rendered PDF's - select to export PDF files. This option is not available when exporting a Pro-
duction set.

» Metadata - use the following options to control the export of the document-level load file and extracted text:
« Data File Format - select a the format for the document-level load file you're exporting:
e Comma separated (.csv)

e Concordance (.dat) - load file exports with the standard Concordance delimiters.

e Custom (.txt) - load file exports with the custom delimiters that you select in the Load File Char-
acters section.

e HTML (.html) - load file is in HTML and contains hyperlinks to launch any exported files.
« Data File Encoding - select an encoding for the document-level load file from the drop-down box. Click
L] for additional options.

» Export Text Field as Files - determines the export of the extracted text or OCR. Select this option if you
want to export files as individual document-level text files, with one file per document. The RDC includes
text as part of your load file if you deselect this option.

* Text File Encoding - select the encoding for the document-level text files. CIickIZI for additional
options.
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e Text Precedence - select and assign an order to long text fields that Relativity checks for text when per-

forming an export. You must select one or more long text fields to use this functionality. ClickEI to dis-
play the Pick Text Precedence pop-up. To move fields between columns, highlight them and click the
Right or Left single or double arrows. Use the Up and Down arrows to order the precedence of the
fields.

i ™
|§| Pick Text Precedence u
Aoailable Long Text Fields Selected Long Text Fields
BCC OCR Text
CC Extracted Text
Comments
Conversation |Ds
Source File
To
>3
l B ——
=
I
L=
<€

If you add any fields to the Selected Long Text Fields column, Relativity adds the Text Precedence
column as the last column in the load file. During an export, Relativity checks the topmost field in the
Selected Long Text Fields column for text, and if the field is null, it checks the next field in order of
precedence for text. When it finds a field that contains text, Relativity adds the contents of that field to the
Text Precedence column in the document load file, and then continues checking the fields for the next
document.

For example, you want the Text Precedence column in the load file to contain the contents of the OCR
Text field when it is available for a document and the contents of the Extracted Text field when the OCR
Text for a document is null. In the Pick Text Precedence pop-up, you add the OCR Text as the first field in
the Selected Long Text Fields column followed by the Extracted Text field.

Note: If you want to improve export performance, you don't need to add all of the long text fields you
select in the Pick Text Precedence pop-up to the Selected Columns option on the Data Source tab.
When you don't select these fields on the Data Source tab, but you add them to Selected Long Text
Fields column, the RDC adds the content of these fields to the Text Precedence column as described
above. When you add the long text fields on the Data Source tab, Relativity adds these columns to the
document level load file.

The Precedence Text column displays the file path to the exported files if you select the Export Text
Field as Files checkbox.

o Export Multiple-Choice Fields as Nested - select this option to maintain the hierarchy of Relativity mul-
tiple-choice lists, when applicable. The nested value delimiter, a backslash, separates child choices.

Desktop Client Guide



4.4 Exporting a saved search

Production Document | Export options
Has native |Hasimage Include original EXPORT res-
production | production images for doc- ults (.opt file)
set set uments that haven't
been produced
Case |YES NO YES produced |YES empty .opt file | N/A
1 images
Case |YES YES YES produced |YES .optfile con- | for production use
2 images tains entries | image place-
with produced | holder: when no
images image exists
Case |NO NO YES original N/A .optfilecon- |[N/A
3 images tains entries
with original
images
Case |NO NO NO original N/A empty .opt file | N/A
4 images
4.4.1 Exporting RDC Permissions
The following permissions are required to use the exporting feature in Relativity Desktop Client:
Object Security Adml.n Oper-
ations
e Document: Local Access (Download, Copy Text) o Allow
Export

Note: This is required when exporting long-text cells greater than the value defined by the
MaximumLongTextSizeForExportinCell instance setting, the default value of which is 1048576.

4.4.2 Exporting a saved search
To export a saved search:

1.

Open the RDC and select a workspace.

fHRelativity
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2. Onthe Tools menu, point to Export and click Saved Search.
The Data Source tab in the Export Production window appears.

Help

Production Set...

Saved Search...

Folder...

Folder and Subfolders...

3. (Optional) To use settings in an existing export file complete these steps:

a. Click the File menu, and select Load Export Settings.
b. Browse for your export settings file (.kwx) in the Open dialog.

c. Select a saved search, and click OK. Your saved search is listed on the Data Source tab, and the set-
tings from the file are used to populate the Destination Files tab. (You can also modify any settings on the
Data Source and Destination Files tab as necessary.)

Note: On the Destination Files tab, you may want to select Overwrite Files if you are re-
exporting the same group of files to the previously used location.

_
/6 Relativity Desktop Client | Select Saved Search (S

MName -

Patent Search

Payoff Search

Fivaot on Responsivensss
Precedence Search

Privilege Check

Privilege Check - Copy
Production Guality Checle
Redacted Documents
Redacted Documents - Copy
Requires Manual Reeun Search
Responsive Search

Responsive Search 2 -

m

4 | 1 | »

d. Continue with step 4.

4. Onthe Data Source, select a saved search in the Searches box. Update the remaining options as necessary.
The Data Source tab appears when you select the option to export production sets, saved searches, folders,
and subfolders. You will see similar options on the tab for each of these actions, but you may want to select
different settings for them. The following screen shot uses a production set as an example, but the settings are
the same when exporting production sets, saved searches, folders, and subfolders.
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On the Data Source tab, you can set the following options for the data that you want to export. Depending on
the type of data you want to export, the dropdown updates accordingly. Select from the following:

Views - Folders and subfolders - select a view for the data that you want to export.
Searches - Saved Search - select a saved search you want to export.
Productions - Production set - select a production set you want to export

Selected Columns - choose the fields that you want to export by moving them to the Selected
Columns box. The box on the right displays all available fields. Only the fields in the Selected Columns
box are exported.

Note: If a reflected production field is selected for Selected Column, the RDC doesn't narrow down the
field to a specific production. The reflected field for all productions is included.

Start Export at Record # - select a record number that identifies the initial document for export. The
RDC exports the document with this record number and continues exporting documents with subsequent
record numbers.

(Available only for Saved Searches, Folders, and Subfolders) Production Precedence - clickIII to dis-
play the Pick Production Precedence dialog where you can select a group of produced documents for
export instead of the original images.

HRelativity
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» Select the images that you want to export:
e Original Images - export only the original, non-produced images.

* Produced Images - export a produced version of the images.

 Include original images... - export original images for the documents that are not in a spe-
cified production.

* Move the productions that you want to exported to the Selected Productions box. To move pro-
ductions between columns, highlight the production and click the Right or Left single or double
arrows. Use the Up and Down arrows to order the precedence of the fields.

Note: Any produced native files will be exported as a native instead of an image. Only one
produced image is exported based on precedence in the list. If the document is in the topmost
production, that version is exported. If not, Relativity checks for the document in the second
production and so on. If the document is not a part of any of the selected productions, and
Include original images ... is enabled, then the original document is produced.

5. Select the Destination Files tab.
On the Destination tab, you can set options that control how the files in folders, searches, and production sets
are exported. The Export dialog displays this tab when you select an Export option from the Tools menu, or
when you right-click on a folder or workspace in the RDC. The Destination tab displays the same options when
you export files in folders, searches, or production sets.
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(5! Relativity Desktop Client | Export Saved Search - O x

File
Data Source  Destination Fils | h
—Export Location — Text and Mative File Names
|Select a folder ... | Named after: | Select.. ~| . |
[~ Overwrite Files [ Append criginal filename
—Physical File Export—— File Path - Image
¥ Copy Files From Repository % Use Relative Paths ¥ Export Images
Data File Format: | Select... -
—Velume Information ——— | T Use Absolute Paths I _I

I— File Type: | Select... -
Prefux: [VOL  Use Prefix I I _I
serz[] = #ofdgits[2 =] [

= : | ¥ Export Native Files ¥ Export rendered POF’s
Max Size (MB): Iﬂ Load File Characters
Column: |1 (ASCII:020) | | [ Metadata
- Subdirectory Information Data File Format [Select .. =]
Image Prefix: [ING Quote:[p (ASCI254) -]
Data File Encoding: | Select... ~] -] 2]
Mative Prefix: INATI‘u’E Newline:I'E) (ASCII174) ﬂ I Export Text Field as Files
Text Prefic [TEXT i - - ?
Mult-Value:[| (ASCIF059) =] || Tt File Encoding:Sdlec.. = | 2]

Pdf Prefix: IF‘DF Text Preoedenne:l |
Mested Value: |% (ASCI1:092
St [1 = sofdigis[3 =1 || e[\ ( )

Max Files:|500 =

L

¥ Export Multiple Choice Fields as Mested

=S

Note: In the Text and Native File Name section, the Named after option is available only for Production Sets.

6. Complete the fields on the Destination Files tab. See Fields on the Destination Files tab on the next page.

7. After you have selected your export settings, select File and click Run.

Note: A warning message is displayed if you are missing information required to run the export. Update the
settings for the required options, and run the export again.

8. Review the progress of the export.
You can view the progress of an export through the RDC. Select the following tabs to display specific
information:

« Summary - displays general information about the number of records, processing warnings, and errors.
The following screen shot displays file progress for an export job.
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|_'-T-| Export Saved Search Progress .., —

161
ltem "AZIPPER_DO0VETE file T1f7fcad-fdfd-4430-a657-892e1b036ack’ processed. [line 162]

63 of 371 processed

Summary | Erors | Progress | Wamings | Report |

Start Time: 3:Z2&:5& EM
Duration: 00:00:11

Time Left to Completion: 00:00:54

Total Becords: 371

Total Processed: €3

Total Processed w/Warnings: 0
Total Processed w/Errors: 0

Average file transfer rate: 473.71 EB/sec
Current katch size: 1,000

Metadata: - Files: Direct - SOL Insert Mode: Bulk

o Errors - lists any errors encountered during the load. The Errors tab displays any errors that occur when
you export content with the RDC.

o Progress - displays a detailed view of the load progress.
« Warnings - displays information about loading or connection issues.

» Report - includes the following files that you can export:
o Export Error Report - exports a .csv file with a summary of errors.

o Export Error File - exports a .dat file, which is a document-level load file containing only records
with errors.

o File Transfer Mode - displays the following information:
» Web mode - this mode uses the web server and it is the standard.
« Direct mode - this mode provides faster performance, but requires a connection to the network

hosting the data, as well as specific Windows group permissions. For more information, see Direct
mode on page 10.

9. (Optional) To save your export settings for reuse, point to the File menu, and click Save Export Settings.
Choose a location for the export settings file (.kwx).

4.4.3 Fields on the Destination Files tab

The Destination Files tab contains the following sections with their respective fields:
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’ Export Location - select a target directory for exporting folders, searches, and production sets. Click

L

—to

browse for a location. Select Overwrite Files to overwrite any existing files of the same name in the target
export directory.

e Physical File Export - select the Copy Files From Repository option. This is the default option and copies
files from the file server to the specified export location. If you don't select Copy Files From Repository,
Relativity doesn't copy the files to the export location. Instead, the exported load files reference the repository
location of the files.

» Volume Information - controls the naming and size of the volume identifier. Set the following options in this
section:

Prefix - enter the alpha prefix for the volume identifier.

Start # - select the first number used for the numeric section of the volume identifier. Multiple volumes
increment numbers during export creating unique volume identifiers.

# of Digits - select the number of digits attached to the prefix. (For example, if you select 3, the outputis
VOLO001, VOL002, and so on.)

Max size - select the maximum size allowed for each volume in MBs.

¢ Subdirectory Information - controls the naming and size of volume subfolders. Set the following options in this
section:

Image Prefix - enter the alpha prefix for the subdirectory that stores exported images.

Native Prefix - enter the alpha prefix for the subdirectory that stores exported native files.
Text Prefix - enter the alpha prefix for the subdirectory that stores exported extracted text files.
Pdf Prefix - enter the alpha prefix for the subdirectory that stores exported extracted PDF files.
Start # - select the starting number for the subdirectories.

# of Digits - select the number of digits of the subdirectory prefix (For example, if you select 3, the output
is IMG001, IMG002, and so on.)

Max Files - select the number of files to store in each subdirectory.

 File Path - controls how the export path for the files is referenced. Select one of the following options:

Use absolute paths - paths to exported files are represented as absolute paths.
C:\ Desktop\VOLOO1\NATIVEOO1\AS000001.msg

Use relative paths - paths to exported files are represented as relative paths.
A\VOLOOT\NATIVEOO1\AS000001.msg

Use prefix - a prefix is added to the relative path, such as a CD drive letter.
D:\VOLOO1\NATIVEOO1\AS000001.msg

e Load File Characters - select the delimiters to use in a document-level load file when Data File Format in the
Metadata section is set to Custom. Select the following options as necessary:

Column - this delimiter separates columns in the load file.

Quote - this delimiter qualifies the text in each field of the load file.

Newline - this delimiter signifies the end of any extracted text or long text field in the load file.
Multi-Value - this delimiter separates different choices within a choice field.

Nested Value - this delimiter indicates the hierarchy of choices within a choice field.
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» Text and Native File Names - select the following options for naming exported native and extracted text files:

Note: The following field types are supported by this feature: Date, Decimal, Fixed-Length Text, Single
Choice, Whole Number, and Yes/No.

e (Available Only for Production Sets) Named after - select one of the following naming convention for exported

files:

« Identifier - select this option to name the files after the identifier for your workspace.

e Beginning production number - select this option to name the files after the production number. (This
number may be the Bates number for a production.)

e Custom - select this option to name the native and text files in an export by appending them with either a
control number or production begin bates and optionally, a field of your choice.
To select custom naming options for your exported native and text files, do the following:

1.

Select Custom from the Named after drop-down menu.

CIickII] to the right of the Named after drop-down menu.

Select either the control number or production begin bates naming option from the drop-down

menu.
-

Optionally, to append a field or custom text to the file name, click .
Select the desired spacing option from the _ (underscore) drop-down menu.

To either add custom text to the name or to add a field to the name, do the following:

e Toinclude custom text as part of the name, choose the Custom Text... option in the drop-
down menu and enter the desired custom text in the textbox underneath the Custom
Text... drop-down menu.

e Toinclude afield as part of the file names, select the desired field option from the Custom
Text... drop-down menu. If a field is empty in a workspace it will not display as part of the file
name even if selected from the Custom Text... drop-down menu.

Note: If a boolean field is selected, the name of the field will be displayed and not the
value. For example: JWOLFE_009_confidential-HAS IMAGES.

El

Optionally, to add an additional field or custom text after the previously selected options, click :
Select the desired spacing option from the _ (underscore) drop-down menu.

To either add additional custom text to the name or to add an additional field to the name, do the
following:

e Toinclude additional custom text as part of the name before a field, choose the Custom
Text... option in the drop-down menu and enter the desired custom text in the textbox under-
neath the Custom Text... drop-down menu.

e Toinclude an additional field as part of the name, select the desired field option from the
Custom Text... drop-down menu. If a field is empty in a workspace it will not display as part
of the file name even if selected from the Custom Text... drop-down menu.
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Note: If a boolean field is selected, the name of the field will be displayed and not the
value. For example: JWOLFE_009_confidential-HAS IMAGES.

10. Click Apply to save the current naming options.

Note: If afile is not found in any of the production sets, the name will revert to the control
number or production begin bates regardless of which naming options you have selected.

e Append original file - Select this option to append the original file name which is defined as the file name as it
was on disk to the end of the exported file name.

* Image - determines whether to include images in an export and sets the format of the load file. Set the following
options:
e Check Export Images - select this option to include images in the export. (You must set the Data File
Format and the File Type when you exportimages.)

» Data File Format - select one of these formats forimage-level load file:
e Opticon

* IPRO

* File Type - select one of these file types:
e Single-page TIF/JPG

e Multi-page TIF
 PDF
» Native - controls which files are exported by Relativity Desktop Client.
e Export Native Files - select to export native files.

e Export rendered PDF's - select to export PDF files. This option is not available when exporting a Pro-
duction set.

» Metadata - use the following options to control the export of the document-level load file and extracted text:
« Data File Format - select a the format for the document-level load file you're exporting:
e Comma separated (.csv)

e Concordance (.dat) - load file exports with the standard Concordance delimiters.

e Custom (.txt) - load file exports with the custom delimiters that you select in the Load File Char-
acters section.

e HTML (.html) - load file is in HTML and contains hyperlinks to launch any exported files.
« Data File Encoding - select an encoding for the document-level load file from the drop-down box. Click
L] for additional options.

» Export Text Field as Files - determines the export of the extracted text or OCR. Select this option if you
want to export files as individual document-level text files, with one file per document. The RDC includes
text as part of your load file if you deselect this option.

* Text File Encoding - select the encoding for the document-level text files. CIickIZI for additional
options.
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e Text Precedence - select and assign an order to long text fields that Relativity checks for text when per-

forming an export. You must select one or more long text fields to use this functionality. ClickEI to dis-
play the Pick Text Precedence pop-up. To move fields between columns, highlight them and click the
Right or Left single or double arrows. Use the Up and Down arrows to order the precedence of the
fields.

i ™
|§| Pick Text Precedence u
Aoailable Long Text Fields Selected Long Text Fields
BCC OCR Text
CC Extracted Text
Comments
Conversation |Ds
Source File
To
>3
l B ——
=
I
L=
<€

If you add any fields to the Selected Long Text Fields column, Relativity adds the Text Precedence
column as the last column in the load file. During an export, Relativity checks the topmost field in the
Selected Long Text Fields column for text, and if the field is null, it checks the next field in order of
precedence for text. When it finds a field that contains text, Relativity adds the contents of that field to the
Text Precedence column in the document load file, and then continues checking the fields for the next
document.

For example, you want the Text Precedence column in the load file to contain the contents of the OCR
Text field when it is available for a document and the contents of the Extracted Text field when the OCR
Text for a document is null. In the Pick Text Precedence pop-up, you add the OCR Text as the first field in
the Selected Long Text Fields column followed by the Extracted Text field.

Note: If you want to improve export performance, you don't need to add all of the long text fields you
select in the Pick Text Precedence pop-up to the Selected Columns option on the Data Source tab.
When you don't select these fields on the Data Source tab, but you add them to Selected Long Text
Fields column, the RDC adds the content of these fields to the Text Precedence column as described
above. When you add the long text fields on the Data Source tab, Relativity adds these columns to the
document level load file.

The Precedence Text column displays the file path to the exported files if you select the Export Text
Field as Files checkbox.

o Export Multiple-Choice Fields as Nested - select this option to maintain the hierarchy of Relativity mul-
tiple-choice lists, when applicable. The nested value delimiter, a backslash, separates child choices.

4.5 Exporting a folder

You can export the contents of a specific workspace folder through the RDC.
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Note: To preserve the current folder structure of each document in a long text field, you have the option of running
the Set Relativity folder path field script when you're exporting a folder through the RDC.

4.5.1 Exporting RDC Permissions

The following permissions are required to use the exporting feature in Relativity Desktop Client:

Object Security Adml.n Oper-
ations
» Document: Local Access (Download, Copy Text) . Allow
Export

Note: This is required when exporting long-text cells greater than the value defined by the
MaximumLongTextSizeForExportinCell instance setting, the default value of which is 1048576.

4.5.2 Exporting a folder

Note: When you select the Folder option, only the contents of the current folder are exported. Use Folder and
Subfolders option to export the contents of both the folder and its subfolders, or the contents of an entire
workspace. See Exporting a folder and its subfolders on page 77.

To export a folder:

1. Open the RDC and then select a workspace.

2. Inthe RDC browser, right-click on a specific folder, point to Export and then click Folder.

You can also highlight a folder in the RDC browser. On the Tools menu, point to Export and click Folder.) The
Data Source tab in the Export Production window appears.

3. (Optional) To use settings in an existing export file, complete these steps:
a. Click theFile menu, and select Load Export Settings.

b. Browse for your export settings file (.kwx) in the Open dialog.

c. Selectaview, and click OK. Your view is listed on the Data Source tab, and determines the fields dis-
played in the Selected Columns box. Other settings from the file are used to populate the Destination
Files tab. (You can also modify any settings on the Data Source and Destination Files tab as necessary.)

Note: On the Destination Files tab, you may want to select Overwrite Files if you are re-exporting the

Desktop Client Guide



same group of files to the previously used location.

MName

Domains
OCR Documents

Responsiveness View 2

0K

d. Continue with step 7.

1. Onthe Data Source tab, select a view in the Views box. Update the remaining options as necessary.
The Data Source tab appears when you select the option to export production sets, saved searches, folders,
and subfolders. You will see similar options on the tab for each of these actions, but you may want to select
different settings for them. The following screen shot uses a production set as an example, but the settings are
the same when exporting production sets, saved searches, folders, and subfolders.

Selected Cohumns Start Export at Record 8
Eanailyhes Indes a Bag Eates I :
Aridnct 1D End/ Bates
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Batch

Bch: Assigned Te
Batch::Balch Set
Baich: Status
Corntrol Mumber
Comversation
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Diate Created Ll *
i
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[iste Recatved

File Size -
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On the Data Source tab, you can set the following options for the data that you want to export. Depending on
the type of data you want to export, the dropdown updates accordingly. Select from the following:

» Views - Folders and subfolders - select a view for the data that you want to export.
e Searches - Saved Search - select a saved search you want to export.

¢ Productions - Production set - select a production set you want to export
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» Selected Columns - choose the fields that you want to export by moving them to the Selected

Columns box. The box on the right displays all available fields. Only the fields in the Selected Columns
box are exported.

Note: If a reflected production field is selected for Selected Column, the RDC doesn't narrow down the
field to a specific production. The reflected field for all productions is included.

Start Export at Record # - select a record number that identifies the initial document for export. The
RDC exports the document with this record number and continues exporting documents with subsequent
record numbers.

(Available only for Saved Searches, Folders, and Subfolders) Production Precedence - cIickE‘ to dis-
play the Pick Production Precedence dialog where you can select a group of produced documents for
export instead of the original images.

x
" Original Images
' Produced Images
I Include original images for documents that haven't been produced
Awvailable Productions Selected Productions
Acme Production
Frod 04

Prod 03
Prod 02

>3

1.
I Ok

— _ Concel |

Al

e Select the images that you want to export:
« Original Images - export only the original, non-produced images.

e Produced Images - export a produced version of the images.

* Include original images... - export original images for the documents that are not in a spe-
cified production.

e Move the productions that you want to exported to the Selected Productions box. To move pro-
ductions between columns, highlight the production and click the Right or Left single or double
arrows. Use the Up and Down arrows to order the precedence of the fields.

Note: Any produced native files will be exported as a native instead of an image. Only one
produced image is exported based on precedence in the list. If the document is in the topmost
production, that version is exported. If not, Relativity checks for the document in the second
production and so on. If the document is not a part of any of the selected productions, and
Include original images ... is enabled, then the original document is produced.
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4. Select the Destination Files tab.
On the Destination tab, you can set options that control how the files in folders, searches, and production sets
are exported. The Export dialog displays this tab when you select an Export option from the Tools menu, or
when you right-click on a folder or workspace in the RDC. The Destination tab displays the same options when

you export files in folders, searches, or production sets.

File

|_*;| Relativity Desktop Client | Export Saved Search

Data Source  Destination Files | _

—Export Location

[Select a folder .

[~ Overwrite Files

—Physical File Export
|v¥ Copy Files From Repository

—Wolume Information

Start#:l‘l 5: #nfdigits:lz 3:
Max Size (MB): IIEBD 3:

Prefix: I‘u"OL

—File Path
' |lse Relative Paths

" lse Absolute Paths

" Use Prefix I

—Load File Characters

—Text and Native File Names

[~ Append original filename

Named after: | Select...

—Image
| Export Images

Data File Format: | Select...

=

File Type: | Select...

=

— Mative
¥ Export Native Files

| Export rendered POF's

Column:[1{ASCII:020)  _~| | [ Metadata
—Subdirectory Information Dats File Format: ISe-Ied... LI
Image Prefix: ING Quote:|p (ASCIL254) |
Data File Encoding: | Select... | | 7 |
Natve Prefix NATVE Newline:|® (ASCIL174) | || ™ Export Text Field as Files
Text Prefix: ITEXT ; . - e
Multi-Value: [ (ASCII059) <] Text File Encoding: |Select... S
Pdf Prefix: [PDF Text Precedence: . |
Nested Value: |\ (A5CI1032) |

Start#: [1 =] #ofdigits:[3 =
=

[ Export Multiple Choice Fields as Nested

Max Files:|500

Note: In the Text and Native File Name section, the Named after option is available only for Production Sets.

5. Complete the fields on the Destination Files tab. See Fields on the Destination Files tab on the next page.

6. After you have selected your export settings, select File and click Run.

Note: A warning message appears if you are missing information required to run the export. Update the
settings for the required options, and run the export again.

7. Review the progress of the export.
You can view the progress of an export through the RDC. Select the following tabs to display specific
information:

o Summary - displays general information about the number of records, processing warnings, and errors.
The following screen shot displays file progress for an export job.
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ltem "AZIPPER_DO0VETE file T1f7fcad-fdfd-4430-a657-892e1b036ack’ processed. [line 162]

63 of 371 processed

Summary | Erors | Progress | Wamings | Report |

Start Time: 3:Z2&:5& EM
Duration: 00:00:11

Time Left to Completion: 00:00:54

Total Becords: 371

Total Processed: €3

Total Processed w/Warnings: 0
Total Processed w/Errors: 0

Average file transfer rate: 473.71 EB/sec
Current katch size: 1,000

Metadata: - Files: Direct - SOL Insert Mode: Bulk

o Errors - lists any errors encountered during the load. The Errors tab displays any errors that occur when
you export content with the RDC.

o Progress - displays a detailed view of the load progress.
« Warnings - displays information about loading or connection issues.

» Report - includes the following files that you can export:
o Export Error Report - exports a .csv file with a summary of errors.

o Export Error File - exports a .dat file, which is a document-level load file containing only records
with errors.

o File Transfer Mode - displays the following information:
» Web mode - this mode uses the web server and it is the standard.
« Direct mode - this mode provides faster performance, but requires a connection to the network

hosting the data, as well as specific Windows group permissions. For more information, see Direct
mode on page 10.

8. (Optional) To save your export settings, point to the File menu, and click Save Export Settings. Choose a loc-
ation for the export settings file (.kwx).

4.5.3 Fields on the Destination Files tab

The Destination Files tab contains the following sections with their respective fields:
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’ Export Location - select a target directory for exporting folders, searches, and production sets. Click

L

—to

browse for a location. Select Overwrite Files to overwrite any existing files of the same name in the target
export directory.

e Physical File Export - select the Copy Files From Repository option. This is the default option and copies
files from the file server to the specified export location. If you don't select Copy Files From Repository,
Relativity doesn't copy the files to the export location. Instead, the exported load files reference the repository
location of the files.

» Volume Information - controls the naming and size of the volume identifier. Set the following options in this
section:

Prefix - enter the alpha prefix for the volume identifier.

Start # - select the first number used for the numeric section of the volume identifier. Multiple volumes
increment numbers during export creating unique volume identifiers.

# of Digits - select the number of digits attached to the prefix. (For example, if you select 3, the outputis
VOLO001, VOL002, and so on.)

Max size - select the maximum size allowed for each volume in MBs.

¢ Subdirectory Information - controls the naming and size of volume subfolders. Set the following options in this
section:

Image Prefix - enter the alpha prefix for the subdirectory that stores exported images.

Native Prefix - enter the alpha prefix for the subdirectory that stores exported native files.
Text Prefix - enter the alpha prefix for the subdirectory that stores exported extracted text files.
Pdf Prefix - enter the alpha prefix for the subdirectory that stores exported extracted PDF files.
Start # - select the starting number for the subdirectories.

# of Digits - select the number of digits of the subdirectory prefix (For example, if you select 3, the output
is IMG001, IMG002, and so on.)

Max Files - select the number of files to store in each subdirectory.

 File Path - controls how the export path for the files is referenced. Select one of the following options:

Use absolute paths - paths to exported files are represented as absolute paths.
C:\ Desktop\VOLOO1\NATIVEOO1\AS000001.msg

Use relative paths - paths to exported files are represented as relative paths.
A\VOLOOT\NATIVEOO1\AS000001.msg

Use prefix - a prefix is added to the relative path, such as a CD drive letter.
D:\VOLOO1\NATIVEOO1\AS000001.msg

e Load File Characters - select the delimiters to use in a document-level load file when Data File Format in the
Metadata section is set to Custom. Select the following options as necessary:

Column - this delimiter separates columns in the load file.

Quote - this delimiter qualifies the text in each field of the load file.

Newline - this delimiter signifies the end of any extracted text or long text field in the load file.
Multi-Value - this delimiter separates different choices within a choice field.

Nested Value - this delimiter indicates the hierarchy of choices within a choice field.
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» Text and Native File Names - select the following options for naming exported native and extracted text files:

Note: The following field types are supported by this feature: Date, Decimal, Fixed-Length Text, Single
Choice, Whole Number, and Yes/No.

e (Available Only for Production Sets) Named after - select one of the following naming convention for exported

files:

« Identifier - select this option to name the files after the identifier for your workspace.

e Beginning production number - select this option to name the files after the production number. (This
number may be the Bates number for a production.)

e Custom - select this option to name the native and text files in an export by appending them with either a
control number or production begin bates and optionally, a field of your choice.
To select custom naming options for your exported native and text files, do the following:

1.

Select Custom from the Named after drop-down menu.

CIickII] to the right of the Named after drop-down menu.

Select either the control number or production begin bates naming option from the drop-down

menu.
-

Optionally, to append a field or custom text to the file name, click .
Select the desired spacing option from the _ (underscore) drop-down menu.

To either add custom text to the name or to add a field to the name, do the following:

e Toinclude custom text as part of the name, choose the Custom Text... option in the drop-
down menu and enter the desired custom text in the textbox underneath the Custom
Text... drop-down menu.

e Toinclude afield as part of the file names, select the desired field option from the Custom
Text... drop-down menu. If a field is empty in a workspace it will not display as part of the file
name even if selected from the Custom Text... drop-down menu.

Note: If a boolean field is selected, the name of the field will be displayed and not the
value. For example: JWOLFE_009_confidential-HAS IMAGES.

El

Optionally, to add an additional field or custom text after the previously selected options, click :
Select the desired spacing option from the _ (underscore) drop-down menu.

To either add additional custom text to the name or to add an additional field to the name, do the
following:

e Toinclude additional custom text as part of the name before a field, choose the Custom
Text... option in the drop-down menu and enter the desired custom text in the textbox under-
neath the Custom Text... drop-down menu.

e Toinclude an additional field as part of the name, select the desired field option from the
Custom Text... drop-down menu. If a field is empty in a workspace it will not display as part
of the file name even if selected from the Custom Text... drop-down menu.
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Note: If a boolean field is selected, the name of the field will be displayed and not the
value. For example: JWOLFE_009_confidential-HAS IMAGES.

10. Click Apply to save the current naming options.

Note: If afile is not found in any of the production sets, the name will revert to the control
number or production begin bates regardless of which naming options you have selected.

e Append original file - Select this option to append the original file name which is defined as the file name as it
was on disk to the end of the exported file name.

* Image - determines whether to include images in an export and sets the format of the load file. Set the following
options:
e Check Export Images - select this option to include images in the export. (You must set the Data File
Format and the File Type when you exportimages.)

» Data File Format - select one of these formats forimage-level load file:
e Opticon

* IPRO

* File Type - select one of these file types:
e Single-page TIF/JPG

e Multi-page TIF
 PDF
» Native - controls which files are exported by Relativity Desktop Client.
e Export Native Files - select to export native files.

e Export rendered PDF's - select to export PDF files. This option is not available when exporting a Pro-
duction set.

» Metadata - use the following options to control the export of the document-level load file and extracted text:
« Data File Format - select a the format for the document-level load file you're exporting:
e Comma separated (.csv)

e Concordance (.dat) - load file exports with the standard Concordance delimiters.

e Custom (.txt) - load file exports with the custom delimiters that you select in the Load File Char-
acters section.

e HTML (.html) - load file is in HTML and contains hyperlinks to launch any exported files.
« Data File Encoding - select an encoding for the document-level load file from the drop-down box. Click
L] for additional options.

» Export Text Field as Files - determines the export of the extracted text or OCR. Select this option if you
want to export files as individual document-level text files, with one file per document. The RDC includes
text as part of your load file if you deselect this option.

* Text File Encoding - select the encoding for the document-level text files. CIickIZI for additional
options.

Desktop Client Guide



e Text Precedence - select and assign an order to long text fields that Relativity checks for text when per-

forming an export. You must select one or more long text fields to use this functionality. ClickEI to dis-
play the Pick Text Precedence pop-up. To move fields between columns, highlight them and click the
Right or Left single or double arrows. Use the Up and Down arrows to order the precedence of the
fields.

i B
|§| Pick Text Precedence u

Aoailable Long Text Fields Selected Long Text Fields

BCC OCR Text

CC Extracted Text
Comments
Conversation |Ds
Source File

To

If you add any fields to the Selected Long Text Fields column, Relativity adds the Text Precedence
column as the last column in the load file. During an export, Relativity checks the topmost field in the
Selected Long Text Fields column for text, and if the field is null, it checks the next field in order of
precedence for text. When it finds a field that contains text, Relativity adds the contents of that field to the
Text Precedence column in the document load file, and then continues checking the fields for the next
document.

For example, you want the Text Precedence column in the load file to contain the contents of the OCR
Text field when it is available for a document and the contents of the Extracted Text field when the OCR
Text for a document is null. In the Pick Text Precedence pop-up, you add the OCR Text as the first field in
the Selected Long Text Fields column followed by the Extracted Text field.

Note: If you want to improve export performance, you don't need to add all of the long text fields you
select in the Pick Text Precedence pop-up to the Selected Columns option on the Data Source tab.
When you don't select these fields on the Data Source tab, but you add them to Selected Long Text
Fields column, the RDC adds the content of these fields to the Text Precedence column as described
above. When you add the long text fields on the Data Source tab, Relativity adds these columns to the
document level load file.

The Precedence Text column displays the file path to the exported files if you select the Export Text
Field as Files checkbox.

o Export Multiple-Choice Fields as Nested - select this option to maintain the hierarchy of Relativity mul-
tiple-choice lists, when applicable. The nested value delimiter, a backslash, separates child choices.

4.6 Exporting a folder and its subfolders

You can export the contents of a folder and its subfolders, as well as an entire workspace, through the RDC.
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Note: To preserve the current folder structure of each document in a long text field, you have the option of running
the Set Relativity folder path field script when you're exporting a folder through the RDC.

4.6.1 Exporting RDC Permissions

The following permissions are required to use the exporting feature in Relativity Desktop Client:

Object Security Adml.n Oper-
ations
» Document: Local Access (Download, Copy Text) . Allow
Export

Note: This is required when exporting long-text cells greater than the value defined by the
MaximumLongTextSizeForExportinCell instance setting, the default value of which is 1048576.

4.6.2 Exporting a folder and its subfolders

Note: You can also export only the content of the current folder using the Folder option. See Exporting a folder on
page 68.

To export a folder and its subfolders:

1. Open the RDC and select a workspace.
2. Inthe RDC browser, right-click on a specific folder, point to Export and then click Folder and Subfolders.

You can also highlight a folder in the RDC browser. On the Tools menu, point to Export and click Folder and
Subfolders.

The Data Source tab in the Export Production window appears.

Note: To export an entire workspace, highlight the root folder.

3. (Optional) To use settings in an existing export file, complete these steps:
a. Click File and select Load Export Settings.

b. Browse for your export settings file (.kwx) in the Open dialog.

c. Select a view, and then click OK. Your view is lists on the Data Source tab. This determines the fields lis-
ted in the Selected Columns box. Other settings from the file are used to populate the Destination Files
tab. You can also modify any settings on the Data Source and Destination Files tab as necessary.

Note: On the Destination Files tab, you may want to select Overwrite Files if you are re-exporting the
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same group of files to the previously used location.

MName
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OCR Documents
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d. Continue with step 7.

4. Onthe Data Source, select a view in the Views box. Update the remaining options as necessary.
The Data Source tab appears when you select the option to export production sets, saved searches, folders,
and subfolders. You will see similar options on the tab for each of these actions, but you may want to select
different settings for them. The following screen shot uses a production set as an example, but the settings are
the same when exporting production sets, saved searches, folders, and subfolders.
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On the Data Source tab, you can set the following options for the data that you want to export. Depending on
the type of data you want to export, the dropdown updates accordingly. Select from the following:

» Views - Folders and subfolders - select a view for the data that you want to export.

e Searches - Saved Search - select a saved search you want to export.
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e Productions - Production set - select a production set you want to export

e Selected Columns - choose the fields that you want to export by moving them to the Selected
Columns box. The box on the right displays all available fields. Only the fields in the Selected Columns
box are exported.

Note: If a reflected production field is selected for Selected Column, the RDC doesn't narrow down the
field to a specific production. The reflected field for all productions is included.

» Start Export at Record # - select a record number that identifies the initial document for export. The
RDC exports the document with this record number and continues exporting documents with subsequent
record numbers.

(Available only for Saved Searches, Folders, and Subfolders) Production Precedence - click L] to dis-
play the Pick Production Precedence dialog where you can select a group of produced documents for
export instead of the original images.

=
" Original Images
¥ Produced Images
I Include original images for documents that haven't been produced
Avzilable Productions Selected Productions
Acme Production
Prod 04

Prod 03
Prod 02

=3

I'n
v Ok

— _ Concel |

Al

e Select the images that you want to export:
e Original Images - export only the original, non-produced images.

e Produced Images - export a produced version of the images.

 Include original images... - export original images for the documents that are not in a spe-
cified production.

* Move the productions that you want to exported to the Selected Productions box. To move pro-
ductions between columns, highlight the production and click the Right or Left single or double
arrows. Use the Up and Down arrows to order the precedence of the fields.
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Note: Any produced native files will be exported as a native instead of an image. Only one
produced image is exported based on precedence in the list. If the document is in the topmost
production, that version is exported. If not, Relativity checks for the document in the second
production and so on. If the document is not a part of any of the selected productions, and
Include original images ... is enabled, then the original document is produced.

5. Select the Destination Files tab.
On the Destination tab, you can set options that control how the files in folders, searches, and production sets
are exported. The Export dialog displays this tab when you select an Export option from the Tools menu, or
when you right-click on a folder or workspace in the RDC. The Destination tab displays the same options when
you export files in folders, searches, or production sets.

[ Relativity Desktop Client | Export Saved Search - O x
File
Data Source Destination Files | h
—Export Location — Text and Mative File Names

|Select a folder . . | Named after: | Select... = .|

[~ Overwrite Files ™ Append original filename
~Physical File Export | [ File Path [ Image

¥ Copy Files From Repository {* |Use Relative Paths ¥ Export Images

Data File Format: | Select... -

—Volume Information ——— | £ Use Absclute Paths I _I

I File Type: | Select... -
oL i Use Prefix I— I _I
Start #: I 1 3: # of digits: |2 3: —Mative

[ =l i | ™ Export Native Files ¥ Export rendered PDF's
Max Size (ME): |50 5 Load File Characters

Column: |1 (ASCII:020) [~ Metadata
" Subdirectory Information ———— Datz File Format: | Select... |

L

e Quote: |b (ASCII:254 ~
MG b B Data File Encoding: | Select... =] ] 2]
Native Prefix: [NATIVE Newline:|® (ASCI174) =] || I Export Text Field as Files
TextPrefic[TEXT i ing: -
i Muli-Value [ BsCilos ] || Tt zee s =171

Pdf Prefix: [PDF Text Precedence: |
Nested Value: |\ (A5CI1-092
Strt#: [1 = #ofdigits:[3 — N }

Max Files:|500 =

L

¥ Export Multiple Choice Fields as Mested

Note: In the Text and Native File Name section, the Named after option is available only for Production Sets.

6. Complete the fields on the Destination Files tab. See Fields on the Destination Files tab on the next page.

7. After you have selected your export settings, select File and then click Run.

Note: A warning message displays if you are missing information required to run the export. Update the
settings for the required options, and run the export again.

8. Review the progress of the export.
You can view the progress of an export through the RDC. Select the following tabs to display specific
information:
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« Summary - displays general information about the number of records, processing warnings, and errors.
The following screen shot displays file progress for an export job.

L Export Saved Search Progress .. -

161
ltem "AZIPPER_DO0VETE file T1ffoed-fdfd-4430-a657-832e1b036ach’ processed. [line 162]

63 of 371 processed

Summary | Emors I Progress | Wamings I Report I

Start Time: 3:2Z2&:5& EM
Duration: 00:00:11

Time Left to Completion: 00:00:54

Total Records: 371

Total Processed: €3

Total Processed w/Warnings: 0
Total Processed w/Errors: 0

Average file transfer rate: 473.71 EBSsec
Current katch size: 1,000

Metadata: - Files: Direct - SOL Insert Mode: Bulk

o Errors - lists any errors encountered during the load. The Errors tab displays any errors that occur when
you export content with the RDC.

o Progress - displays a detailed view of the load progress.
« Warnings - displays information about loading or connection issues.

e Report - includes the following files that you can export:
o Export Error Report - exports a .csv file with a summary of errors.
o Export Error File - exports a .dat file, which is a document-level load file containing only records
with errors.
o File Transfer Mode - displays the following information:
» Web mode - this mode uses the web server and it is the standard.
« Direct mode - this mode provides faster performance, but requires a connection to the network

hosting the data, as well as specific Windows group permissions. For more information, see Direct
mode on page 10.

9. (Optional) To save your export settings, click File > Save Export Settings. Choose a location for the export set-
tings file (.kwx).

4.6.3 Fields on the Destination Files tab

The Destination Files tab contains the following sections with their respective fields:
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Export Location - select a target directory for exporting folders, searches, and production sets. Click

L

—to

browse for a location. Select Overwrite Files to overwrite any existing files of the same name in the target
export directory.

« Physical File Export - select the Copy Files From Repository option. This is the default option and copies
files from the file server to the specified export location. If you don't select Copy Files From Repository,
Relativity doesn't copy the files to the export location. Instead, the exported load files reference the repository
location of the files.

« Volume Information - controls the naming and size of the volume identifier. Set the following options in this
section:

Prefix - enter the alpha prefix for the volume identifier.

Start # - select the first number used for the numeric section of the volume identifier. Multiple volumes
increment numbers during export creating unique volume identifiers.

# of Digits - select the number of digits attached to the prefix. (For example, if you select 3, the output is
VOLO001, VOL002, and so on.)

Max size - select the maximum size allowed for each volume in MBs.

« Subdirectory Information - controls the naming and size of volume subfolders. Set the following options in this
section:

Image Prefix - enter the alpha prefix for the subdirectory that stores exported images.

Native Prefix - enter the alpha prefix for the subdirectory that stores exported native files.
Text Prefix - enter the alpha prefix for the subdirectory that stores exported extracted text files.
Pdf Prefix - enter the alpha prefix for the subdirectory that stores exported extracted PDF files.
Start # - select the starting number for the subdirectories.

# of Digits - select the number of digits of the subdirectory prefix (For example, if you select 3, the output
is IMGO001, IMG002, and so on.)

Max Files - select the number of files to store in each subdirectory.

« File Path - controls how the export path for the files is referenced. Select one of the following options:

Use absolute paths - paths to exported files are represented as absolute paths.
C:\ Desktop\VOLOO1\NATIVEOO1\AS000001.msg

Use relative paths - paths to exported files are represented as relative paths.
\VOLOO1\NATIVEOO1\AS000001.msg

Use prefix - a prefix is added to the relative path, such as a CD drive letter.
D:\VOLOO1\NATIVEOO1\AS000001.msg

o Load File Characters - select the delimiters to use in a document-level load file when Data File Format in the
Metadata section is set to Custom. Select the following options as necessary:

Column - this delimiter separates columns in the load file.

Quote - this delimiter qualifies the text in each field of the load file.

Newline - this delimiter signifies the end of any extracted text or long text field in the load file.
Multi-Value - this delimiter separates different choices within a choice field.

Nested Value - this delimiter indicates the hierarchy of choices within a choice field.
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« Text and Native File Names - select the following options for naming exported native and extracted text files:

Note: The following field types are supported by this feature: Date, Decimal, Fixed-Length Text, Single
Choice, Whole Number, and Yes/No.

« (Available Only for Production Sets) Named after - select one of the following naming convention for exported

files:

« Identifier - select this option to name the files after the identifier for your workspace.

« Beginning production number - select this option to name the files after the production number. (This
number may be the Bates number for a production.)

o Custom - select this option to name the native and text files in an export by appending them with either a
control number or production begin bates and optionally, a field of your choice.
To select custom naming options for your exported native and text files, do the following:

1.

Select Custom from the Named after drop-down menu.

ClickIII to the right of the Named after drop-down menu.

Select either the control number or production begin bates naming option from the drop-down

menu.
|

Optionally, to append a field or custom text to the file name, click .

5. Select the desired spacing option from the _ (underscore) drop-down menu.

To either add custom text to the name or to add a field to the name, do the following:

e Toinclude custom text as part of the name, choose the Custom Text... option in the drop-
down menu and enter the desired custom text in the textbox underneath the Custom
Text... drop-down menu.

o Toinclude a field as part of the file names, select the desired field option from the Custom
Text... drop-down menu. If a field is empty in a workspace it will not display as part of the file
name even if selected from the Custom Text... drop-down menu.

Note: If a boolean field is selected, the name of the field will be displayed and not the
value. For example: JWOLFE_ 009 confidential-HAS IMAGES.

E

Optionally, to add an additional field or custom text after the previously selected options, click .
Select the desired spacing option from the _ (underscore) drop-down menu.

To either add additional custom text to the name or to add an additional field to the name, do the
following:

o Toinclude additional custom text as part of the name before a field, choose the Custom
Text... option in the drop-down menu and enter the desired custom text in the textbox
underneath the Custom Text... drop-down menu.

o Toinclude an additional field as part of the name, select the desired field option from the
Custom Text... drop-down menu. If a field is empty in a workspace it will not display as part
of the file name even if selected from the Custom Text... drop-down menu.

Note: If a boolean field is selected, the name of the field will be displayed and not the
value. For example: JWOLFE_009_confidential-HAS IMAGES.
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10. Click Apply to save the current naming options.

Note: If afile is not found in any of the production sets, the name will revert to the control
number or production begin bates regardless of which naming options you have selected.

o Append original file - Select this option to append the original file name which is defined as the file name as it
was on disk to the end of the exported file name.

« Image - determines whether to include images in an export and sets the format of the load file. Set the following
options:
o Check Export Images - select this option to include images in the export. (You must set the Data File
Format and the File Type when you exportimages.)

« Data File Format - select one of these formats for image-level load file:
e Opticon
« IPRO

« File Type - select one of these file types:
« Single-page TIF/JPG
o Multi-page TIF
o PDF

« Native - controls which files are exported by Relativity Desktop Client.
« Export Native Files - select to export native files.

o Export rendered PDF's - select to export PDF files. This option is not available when exporting a
Production set.

» Metadata - use the following options to control the export of the document-level load file and extracted text:
« Data File Format - select a the format for the document-level load file you're exporting:
o Comma separated (.csv)

o Concordance (.dat) - load file exports with the standard Concordance delimiters.

o Custom (.txt) - load file exports with the custom delimiters that you select in the Load File
Characters section.

o HTML (.html) - load file is in HTML and contains hyperlinks to launch any exported files.

« Data File Encoding - select an encoding for the document-level load file from the drop-down box. Click

] for additional options.

» Export Text Field as Files - determines the export of the extracted text or OCR. Select this option if you
want to export files as individual document-level text files, with one file per document. The RDC includes
text as part of your load file if you deselect this option.

Text File Encoding - select the encoding for the document-level text files. CIickEl for additional
options.

» Text Precedence - select and assign an order to long text fields that Relativity checks for text when

performing an export. You must select one or more long text fields to use this functionality. ClicklzI to
display the Pick Text Precedence pop-up. To move fields between columns, highlight them and click the
Right or Left single or double arrows. Use the Up and Down arrows to order the precedence of the
fields.
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If you add any fields to the Selected Long Text Fields column, Relativity adds the Text Precedence
column as the last column in the load file. During an export, Relativity checks the topmost field in the
Selected Long Text Fields column for text, and if the field is null, it checks the next field in order of
precedence for text. When it finds a field that contains text, Relativity adds the contents of that field to the
Text Precedence column in the document load file, and then continues checking the fields for the next
document.

For example, you want the Text Precedence column in the load file to contain the contents of the OCR
Text field when it is available for a document and the contents of the Extracted Text field when the OCR
Text for a document is null. In the Pick Text Precedence pop-up, you add the OCR Text as the first field in
the Selected Long Text Fields column followed by the Extracted Text field.

Note: If you want to improve export performance, you don't need to add all of the long text fields you
select in the Pick Text Precedence pop-up to the Selected Columns option on the Data Source tab.
When you don't select these fields on the Data Source tab, but you add them to Selected Long Text
Fields column, the RDC adds the content of these fields to the Text Precedence column as described
above. When you add the long text fields on the Data Source tab, Relativity adds these columns to the
document level load file.

The Precedence Text column displays the file path to the exported files if you select the Export Text
Field as Files checkbox.

« Export Multiple-Choice Fields as Nested - select this option to maintain the hierarchy of Relativity
multiple-choice lists, when applicable. The nested value delimiter, a backslash, separates child choices.
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5 Configuring the RDC

You can fine-tune the performance of the RDC in your environment by adjusting its configuration settings, for
example, for batching, data validation, and retries.

5.1 RDC configuration file

You can use the information in this section to update the configuration settings used by the RDC. The Import API also
uses these same settings located in the app.config file.

Use the following instructions to locate the config file on your machine, and set custom configuration properties for the

RDC:

1. Exitthe RDC ifitis currently open.

2. Navigate to the Relativity.Desktop.Client.exe.config file on the machine where the RDC is installed. By
default, this configuration file is located in the following directory:
[Installation_Directory]\kCura Corporation\Relativity Desktop Client

Note: Make a backup copy of this file in case you need to rollback any configuration changes made to it.

3. Open the Relativity.Desktop.Client.exe.config file in a text or XML editor and modify it as necessary.

5.1.1 Configuration settings

The Relativity.DataExchange section of the Relativity.Desktop.Client.exe.config contains the configuration

properties in the following table.

5.1.1.1 General settings

Name

Description

Default Value

CreateErrorForlnvalidDate

When this value is set to True, a zeroed date, such as
0/0/0000, causes an Invalid Date error. When False, the
date is treated as a NULL value.

True

FileTypeldentifyTimeoutSeconds

Defines the maximum number of seconds to identify a file
type before reaching the timeout.

HttpExtractedTextTimeoutSeconds

Defines the timeout, in seconds, for HTTP/REST-based API
web services specifically used for extracted text.

Note: This value doesn't impact WebAPI-based web
services, which means that WebAPI|OperationTimeout
setting is still honored.

900

HttpTimeoutSeconds

Defines the timeout, in seconds, for HTTP/REST-based API
web services.

Note: This value doesn't impact WebAPI-based web
services, which means the WebAPIOperationTimeout
setting is still honored.

300

IOErrorNumberOfRetries

Defines the number of times the RDC retries an operation
within an import or export process after an 10 failure occurs.

20

IOErrorWaitTimelnSeconds

Defines the number of seconds the RDC waits before

30
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Name Description Default Value

retrying an operation within an import or export process after
an |0 failure occurs.

LogAllEvents Enables an option to Save Progress Log when job com- False

pletes.
LogConfigFile Defines the Relativity Logging configuration file name. LogConfig.xml
SuppressCertificateCheckOnClient | When this value is set to True, SSL certificate validation False

errors are suppressed. When False, SSL certificate val-
idation errors cause job failures.

TempDirectory Defines a temp directory override where short lived import
files are stored. When not defined, the user profile
%TEMP% directory is used.

WebAPIOperationTimeout Defines the time in milliseconds, which an XML Web service | 600000
client waits for the reply to a synchronous XML Web service
request to arrive.

5.1.1.2 Transfer settings

Name Description Default Value

BadPathErrorsRetry When this value is set to True, bad path errors are retried dur-| True
ing a transfer. When False, permission errors aren't retried
and cause job failures.

PermissionErrorsRetry When this value is set to True, permission errors are retried | True
before and during a transfer. When False, permission errors
aren't retried and cause job failures.

TapiAsperaBcpRootFolder Defines the root folder where the BCP files are uploaded
when using the Aspera transfer client.

TapiFileNotFoundErrorsDisabled | When this value is set to True, missing files aren't treated as | False
errors. When False, missing files are treated as errors.

TapiFileNotFoundErrorsRetry When this value is set to True, missing files are retried. True
When False, missing files aren't retried.

TapiForceAsperaClient When this value is set to True, the Aspera transfer client is False
forced. When False, the best fit transfer client is chosen at
runtime.

TapiForceBcpHttpClient When this value is set to True, the HTTP transfer client is False

forced only for BCP operations. When false, the best fit trans-
fer client is chosen at runtime.

TapiForceClientCandidates Forces an ordered list of transfer clients when probing a work-
space and choosing the best client. This value represents a
semi-colon delimited list. Native transfer client identifiers
must be used, such as FileShare, Aspera, or Http.

TapiForceFileShareClient When this value is set to True, the file share transfer clientis | False
forced. When False, the best fit transfer client is chosen at
runtime.
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Name

Description

Default Value

TapiForceHttpClient

When this value is set to True, the HTTP transfer client is
forced. When false, the best fit transfer client is chosen at
runtime.

Note: This setting is the same as web mode.

False

TapiLargeFileProgressEnabled

When this value is set to True, large-file progress is used by
transfer clients to display "Trip x of y" chunk info within the
status area. When False, no chunk info is displayed .

False

TapiMaxInactivitySeconds

The maximum number of seconds that elapse with no data
movement occurring before the transfer is treated as inact-
ive. When this occurs, the import or export job continues but
performance may be degraded.

180

TapiMaxJobParallelism

Defines the maximum degree of parallelism for a transfer cli-
entjob. This value isn't guaranteed to be honored by all cli-
ents.

10

TapiMinDataRateMbps

Defines the minimum data rate in Mbps units. If set to zero,
the best value is chosen. This value isn't guaranteed to be
honored by all clients.

TapiPreserveFileTimestamps

When this value is set to True, the RDC preserves the import
and export file timestamps. Only direct modes support this
functionality.

Note: By default, this value is set to False, because
preserving file timestamps may degrade performance
between 10-20%.

False

TapiTargetDataRateMbps

Defines the target data rate in Mbps units. This value isn't
guaranteed to be honored by all clients.

100

TapiTransferLogDirectory

Defines the directory where Relativity Logging and transfer
clientlogs are stored.

%temp%\RDC _
log\

5.1.1.3 Import settings

Name

Description

Default
Value

AuditLevel

Controls the details collected in an audit:

¢ FullAudit - includes create, update, and delete messages.
Snapshot is also enabled so all current field values (Audit
Details) are captured for updates. This is the default setting.

¢ NoSnapshot - Includes create, update, and delete mes-
sages. Snapshot is disabled so current field values (Audit

Details) aren't captured for updates.

¢ NoAudit - Auditing is disabled.

FullAudit

CreateErrorForlnvalidDate

When this value is set to True, a zeroed date, such as 0/0/0000, True

HRelativity

Desktop Client Guide

89




Name

Description

Default
Value

causes an Invalid Date error. When False, the date is treated as a
NULL value.

DisablelImagelLocationValidation

Disables the validation of the image file locations for all jobs when
set to True. See Additional guidelines for disabling file validation
below.

False

DisablelmageTypeValidation

Disables the validation of image file types for all jobs when set to
True. Image type validation is dependent upon image location val-
idation. See Additional guidelines for disabling file validation below.

False

DisableNativelLocationValidation

Disables the validation of the native file locations for all jobs when
set to True. See Additional guidelines for disabling file validation
below.

Note: Don't use the DisableNativeLocationValidation flag when
copying files to a repository. File locations are validated
regardless of the flag before they are copied.

False

DisableNativeValidation

Disable the validation of native file types for all jobs. Native type val-

idation is dependent upon native location validation. See Additional

guidelines for disabling file validation below.

False

DynamicBatchResizingOn

When this value is set to True, the batch size is automatically
decreased by 100 when a large import job is in progress, and it
causes a timeout.

True

ImportBatchMaxVolume

Defines the maximum number of bytes before the metadata is
imported.

10485760

ImportBatchSize

Defines the maximum number of documents or objects before the
metadata is imported.

1000

JobCompleteBatchSize

Defines the file count threshold at which the RDC completes and
recreates the transfer job used to transfer files.

50000

MinimumBatchSize

When AutoBatch is set to True, this value represents the lower
bound on the batch size. Batch sizes can't be smaller than this
value.

100

Additional guidelines for disabling file validation
You can disable file validation by setting these configuration settings to true:

e DisablelmagelLocationValidation

» DisablelmageTypeValidation

¢ DisableNativeLocationValidation

¢ DisableNativeValidation

Review the following guidelines before disabling file validation:

* When you disable file type validation, you do not receive any warnings regarding unsupported file types. It's
therefore possible for files to be imaged and result in errors.
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» Disabling the file type validation also causes the application to set the Relativity Native Types field to Unknown
Format.

e Setting a native type to unknown has no effect on productions or OCR.
e Setting a native type to unknown has no effect on how the viewer or imaging engine handles the file. This
means that a native type of unknown can't be the sole cause of an error in the viewer or the imaging

engine. If a file is designated unknown and it actually has an unsupported file type, the Viewer or imaging
engine throws an error based on the fact that it has an unsupported file type.

5.1.1.4 Export settings

Default

Name Description Value

ExportBatchSize Defines the maximum number of export documents per batch. 1000

ExportErrorNumberOfRetries Defines the number of times the RDC retries an operation withinan |20
export process after a non-10 failure. This value should be greater
than or equal to the IOErrorNumberOfRetries value.

ExportErrorWaitTimelnSeconds | Defines the number of seconds the RDC waits before retrying an 30
operation within an export process after a non-10 failure. This value
should be greater than or equal to the IOErrorWaitTimelnSeconds
value.

ExportThreadCount Defines the number of threads that get created during export. 2

Note: This configuration setting is only used when the
UseOlIdExport setting is true.

UseOldExport When this value is set to True, the legacy export method is used. False
When False, the new export method is used. The old export should
only be used when encountering compatibility issues.
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Proprietary Rights

This documentation (“Documentation”) and the software to which it relates (“Software”) belongs to Relativity ODA
LLC and/or Relativity’s third party software vendors. Relativity grants written license agreements which contain
restrictions. All parties accessing the Documentation or Software must: respect proprietary rights of Relativity and
third parties; comply with your organization’s license agreement, including but not limited to license restrictions on
use, copying, modifications, reverse engineering, and derivative products; and refrain from any misuse or
misappropriation of this Documentation or Software in whole or in part. The Software and Documentation is
protected by the Copyright Act of 1976, as amended, and the Software code is protected by the lllinois Trade
Secrets Act. Violations can involve substantial civil liabilities, exemplary damages, and criminal penalties,
including fines and possible imprisonment.

©2025. Relativity ODA LLC. All rights reserved. Relativity® is a registered trademark of Relativity ODA
LLC.

Desktop Client Guide



	1 Overview
	1.1 RDC menu bar
	1.2 Workspace folder options
	1.3 Starting the RDC
	1.4 Logging on to the RDC
	1.5 RDC OAuth2 client
	1.6 RDC transfer modes
	1.6.1 Direct mode


	2 Using the RDC installer
	2.1 Software requirements
	2.2 Downloading the RDC installer
	2.3 Installing the RDC
	2.4 Installing the RDC in quiet mode
	2.5 Repairing or removing RDC installation

	3 Importing through the RDC
	3.1 Importing RDC Permissions
	3.2 Importing multiple load files simultaneously
	3.3 Handling errors
	3.4 Saving import settings
	3.4.1 Saving a field map

	3.5 Viewing audit information for an import
	3.6 Load file specifications
	3.6.1 Supported file types
	3.6.2 Metadata, extracted text, and native files
	3.6.3 Image and extracted text files
	3.6.4 Processed data

	3.7 Importing document metadata, files, and extracted text
	3.7.1 Importing RDC Permissions
	3.7.2 Importing documents
	3.7.3 Importing Yes/No fields on documents
	3.7.4 Stopping an import or export job

	3.8 Importing an image file
	3.8.1 Importing RDC Permissions
	3.8.2 Importing images

	3.9 Importing a production file
	3.9.1 Special considerations
	3.9.2 Importing RDC Permissions
	3.9.3 Importing a production

	3.10 Import errors for Desktop Client

	4 Exporting with the RDC
	4.1 Exporting RDC Permissions
	4.2 Technical considerations for .kwx files
	4.3 Exporting a production set
	4.3.1 Exporting RDC Permissions
	4.3.2 Exporting a production set
	4.3.3 Fields on the Destination Files tab

	4.4 Exporting a saved search
	4.4.1 Exporting RDC Permissions
	4.4.2 Exporting a saved search
	4.4.3 Fields on the Destination Files tab

	4.5 Exporting a folder
	4.5.1 Exporting RDC Permissions
	4.5.2 Exporting a folder
	4.5.3 Fields on the Destination Files tab

	4.6 Exporting a folder and its subfolders
	4.6.1 Exporting RDC Permissions
	4.6.2 Exporting a folder and its subfolders
	4.6.3 Fields on the Destination Files tab


	5 Configuring the RDC
	5.1 RDC configuration file
	5.1.1 Configuration settings



